MIER College of Education (Autonomous)
Accredited by the NAAC with ‘A+’ Grade

CRITERION 11
TEACHING LEARNING AND EVALUATION
2.4 Competency and Skill Development

(2.4.1 Institution provides opportunities for developing competencies and

1.
2.
3
4.
S
6.
T
8.
9.

\

skills in different functional areas through spccially designed
activities / experiences that include

Organizing Learning (lesson plan)

Developing Teaching Competencies

Assessment of Learning

Technology Use and Integration

Organizing Field Visits

Conducting Outreach/ Out of Classroom Activities
Community Engagement

Facilitating Inclusive Education

Preparing Individualized Educational Plan(IEP)

1. Documentary evidence in support of the selected
response/s




Documentary Evidence in Support of Each Response/s

S.NO.

DESCRIPTION

ENCLOSURE

L.

Organizing Learning
(Lesson Plan)

. Sample Lesson plan of M.Ed. Spl. Edu. ID for Teaching

Practice Field Engagement Practice

. Sample lesson Plan of B.Ed. Sem. IIl through RCEM

approach (2022-24)

. Sample lesson plan of M.Ed. Sem. III through constructivist

approach (2022-24)

. Sample Lesson plan for resource room teaching of B.Ed.

Spl. Edu. (ID) Sem. IIT (2022-24)

Developing Teaching
Competencies

. Sample Micro lesson of B.Ed. Sem. Il (2022-24)

. Circular of workshop on communication skills for the

students of B.Ed. Sem. IIT (2022-24)

. Circular of workshop on communication skills for the

students of B.Ed. Spl. Edu. (ID) Sem. III (2022-24)

. Circular cum schedule of workshop on Digital Literacy (MS

Office) for the students of B.Ed. Spl. Edu. (ID) and M.Ed.
Sem. I1I (2022-24)

Assessment of Learning

. Sample of question papers prepared by student of M.Ed.

Sem. Il as a part of Internship

. Sample of question papers prepared by student of B.Ed.

Sem. IV as a part of Internship.

. Sample of Online quiz prepared by M.Ed. Sem. II (2022-24)

Technology Use and
Integration

. Sample of ICT lesson of M.Ed. Sem. II (2022-24)

. Photographic evidence of technology use and integration for

developing competencies and skills among students

. Sample of sessional work of M.Ed. Sem. II (2022-24) for

course Innovative use of technology in use of research MED
204




Organizing Field Visits

. Circular of field visit to Sher-e-Kashmir University of

Agricultural Sciences and Technology regarding organic

farming systems Vermi compositing

. Circular of field visit to Government Polytechnic college,

Bikram chowk, Jammu regarding course work BDE 104 and
MED 305.

. Copy of letter to Principal Govt. Polytechnic College

seeking permission for field visit.

. Circular of visit to NIMBARK, Jammu

Conducting Outreach/ . Programme Schedule of event based on Healthy Practices
Out of Classroom related to Environment
Activities :
. Programme Schedule of Tug of War organised by Sports
Unit
Community . Duty sheet of World Health day
Engagement . Duty Sheet of Awareness regarding importance of voting.

. Duty Sheet of Nukkad Natak on Aids

Facilitating Inclusive
Education

. Letter to Principal Model Academy for Resource room

Teaching of B.Ed. Spl. Edu. (ID) Sem. III (2022-24)

. Lesson Plan of Resource Room Teaching of B.Ed. Spl. Edu.

(ID) Sem. 111 (2022-24)

. Letter to Principal Model Academy for Group Teaching of

B.Ed. Spl. Edu. (ID) Sem. III (2022-24)

. Lesson Plan of Group Teaching of B.Ed. Spl. Edu. (ID)

Sem. IIT (2022-24)

Preparing
Individualized
Educational Plan(TEP)

. Sample copy of IEP prepared by student of B.Ed. Spl. Edu.

(ID) Sem. .III (Refer Metrix No. 2.3.7)




7Y MIER College of Education (Autonomous)
N Accredited by the NAAC with ‘A+ Grade

CRITERION II
TEACHING LEARNING AND EVALUATION
2.4 Competency and Skill Development

(

N

2.4.1 Institution provides opportunities for developing competencies and
skills in different functional areas through specially designed
activities / experiences that include

1. Organizing Learning (lesson plan)




SAMPLE OF LESSON
PLANS
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Thirty Supervised Lessons (15 in each subject) through RCEM
Approach
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Teacher's Activities
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CONSTRUCTIVIST LESSON PLAN -9
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Explain

e Student Activi%:




Elaborate




Evaluate
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Constructivist Lesson Plan Rubric

T

Not Present

Beginning

Developing

Achieved |

0

|

2

3

—_—
Constructivist Model Components

_—

€arning phases are implemented in the Tesson
(Phases: experience, interpretation, exploration,
€ngagement, engagement, identification,
organization, application, explanation, elaboration,

The activities are interactive and student centered

Learners are actively involved

The teacher facilitates process of learning in
which students are encouraged to be responsible and

independent

Existing Knowledge

Existing Knowledge is probed

Misconceptions are given a chance to be revealed

Predictive or discrepant events are presented

Situated Cognition

Activities or portions of activities authentic or put
forward with authentic Big Ideas

Social learning is present and integral to activities

Dialogue is available for misconception redemption

Construction of Knowledge

Students are given the opportunity to apply new
ideas of different situations by examining prior

conceptions and applying them to new knowledqge

Lab, situations or inquiry activities are present, to
help students generate new ideas

Students are asked to question their beliefs and
test their ideas through self-reflection

Metacognition : BN e AR

Learning goods are clear

Students are asked to confront pre-conceptions

Students self-assess their progress (self-reflection)
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CRITERION 11
TEACHING LEARNING AND EVALUATION
2.4 Competency and Skill Development

2.4.1 Institution provides opportunities for developing competencies and
skills in different functional areas through specially designed
L activities / experiences that include

2. Developing teaching competencies




SAMPLE OF MICRO
LESSON PLAN
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Micro Teaching Practice: Twenty Micro lessons, two
lessons of each skill in the opted subject

¢ Skill of Questioning

o Skill of Reinforcement

e Skill of Stimulus Variation

e Skill of Explanation

e Skill of lllustrations with examples and visuals
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CIRCULARS



N MIER College of Education (Autonomous)

Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu
Accredited by the NAAC with ‘A+” Grade

SCHOOL OF EDUCATION

QF: 028A
Ref. No. MCE/SOE/March/2024/306

Dt: 13/03/2024

CIRCULAR

It is for the information of all the students of B.Ed. Semester-III, Session 2022-24 that as a part
of Life Skill Programme, a workshop on Communication Skills is being organized from 20 March, 2024 to

31 April, 2024 at 01:30 p.m. to 02:10 p-m. Mrs, Maneka Khanna will conduct the session. It is mandatory for
all the students to attend. Certificate for life skill programme will be awarded to the participants.

= i
s
HOD

School of Education

Copy to: -

Principal, MIER Collegé of Education.
IQAC

Mrs. Maneka Khanna
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MIER College of Education (Autonomous)

College with Potential for Excellence Status by the UGC
Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu
Accredited by the NAAC with ‘A+’ Grade

SCHOOL OF EDUCATION

QF: 028B
Ref. No. MCE/SOE/November/2023/226 A
Dt: 20/11/2023

CIRCULAR

It is for the information of all the students of B.Ed. Special Education (ID) Semester-I11, Session
2022-24 that as a part of Life Skill Programme, a workshop on Communication Skills is being organized from
22" November, 2023 to 1% December, 2023 at 12:50 p-m. to 01:30 p.m. Ms. Maneka Khanna will conduct the

session. It is mandatory for all the students to attend. Certificate for life skill programme will be awarded to the

participants.
School of Education
o lul2
Copy to: -

1. Principal, MIER College of Education.
2. Ms. Maneka Khanna



. ™ MIER College of Education (Autonomous)

Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu
Accredited by the NAAC with ‘A+’ Grade

SCHOOL OF EDUCATION
QF: 028B&C
Ref. No. MCE/SOE/March 2024/307
Dt: 13-03-2024
CIRCULAR

It is for the information of all the students of B.Ed. Special Education & M.Ed. Semester-I11, Session 2022-24 that
as a part of Life Skill Programme, a workshop on Digital Literacy (MS Office) is being organized from 20" March, 2024
to 27" March, 2024 at 01:30 pm to 02:10 pm in the Computer Lab, Administration block. Mr. Sachin Prabhakar and
Mrs. Rohini Sharma will conduct these training sessions which are mandatory for the all the students of the programme.

The following schedule shall be followed for this workshop:

Date Content Group Resource Person
20-03-2024 | o Introduction to MS Word and Excel

21-03-2024 | e Conversion of documents in

different extensions., Mrs. Rohini Sharma
Demonstration of Google docs and B.Ed. Spl. Edu. (ID)
Drive Sem. 111 (2022-24)
22-03-2024 | e Introduction to Virtual Platforms: and
Google Meet, Zoom , Skype M.Ed

26-03-2024 | e Introduction to Al

¢ Introduction to Canva.
27-03-2024 | e Introduction to Picxart.
e Introduction to Quillbot

Sem. 11 (2022-24) Mr. Sachin Prabhakar

6.
AL
HOD
School of Education

Email Copy to: -
1. Principal, MIER College of Education.
2. IQAC
3. Mr. Sachin Prabhakar and Mrs. Rohini Sharma



1% MIER College of Education (Autonomous)

Accredited by the NAAC with ‘A+’ Grade

CRITERION II
TEACHING LEARNING AND EVALUATION

2.4 Competency and Skill Development

y

2.4.1

\

Institution provides opportunities for developing competencies and
skills in different functional areas through specially designed
activities / experiences that include

»

3.Assessment of Learning




SAMPLE OF
ASSESMENT OF
LEARNING
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{1}y MIER COLLEGE OF EDUCATION (Autonomous)

; College with Potential for Excellence Status by the UGC

Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu
Accredited by the NAAC with ‘A+’ Grade

SCHOOL OF EDUCATION

REFLECTIVE JOURNAL
ON
INTERNSHIP

M.Ed. Semester-II
(Session 2022-24)

----------------------------------------------------------------------
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EVALUATION SHEET

INTERNSHIP (MED-2035)
S. Cositani Maximum | Marks
No. Marks Obtained
1 Visit to DIET / SIE and submission of 10 9
the report
Observation of five lessons in
, | perspective papers of the B.Ed. Course 0 A
delivered by regular teachers of the
college
3 Delivery of five lessons in perspective )5 90

papers of the B.Ed. Course

Observation of five lessons of teaching
4. |work of the peer group in perspective 20 1"+
papers of the B.Ed. Course

Preparation of five question papers

5. | from perspective papers of the B.Ed. 20 1€
Course
Writing a reflective journal —on

6. |activities carried out during the 15 | |
Internship

Total 100 RO

L S

Signature of Supervisors

1. (R 2.

) "5 5 8
\ W

\ )}
Head of the Department
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[Total No. of Questions-9]

Time Allowed: 3 Hours

[Total Nn. of Printed Pages-2]

B.Ed. Semester-1l Examination
B.Ed.-11/10/23
Assessment for Learning
Course Code: BED-202
(2022-24)

Maximum Marks: 60

Minimum Pass Marks: 24

Note: i) Attempt five questions in all, selecting one question from each

unit. Question No. 1 is compulsory.

i) All the questions carry equal marks.

1. Write note on each of the following in about 50-75 words:

a) Difference between formative and summative evaluation.
b) Interval scale of measurement

c) Criteria of a good test.

d) Sociometry as a qualitative tool of evaluation.
{3,3, 3.3}

UNIT-I

Differentiate between assessment, evaluation and measurement based on

their meanings and importance in the educational context. (4,4,4)

Explain the concept and process of Continuous and Comprehensive

Evaluation (CCE). (4,8)

__—UNIT-lI

What are qualitative and quantitative approaches for assessment? (6,6)
Explain the outcomes of assessment of learning outcomes for affective

Domain. Elaborate on the role of teacher as 2 facilitator in assessment for

(F



Learning. (8,4)
UNIT-1ll
Describe standardized and diagnostic test. Give their advantages and

limitations. (6,6)

What is 2 norm-referenced test? Explain its importance and the steps in

The development of a norm-referenced test. (3,3,6)
UNIT-IV
Explain rubrics in detail as one of the techniques of assessment. (12)
Define credit-system. Explain its need and limitations. (3,6,3)
sk ok sk sk ok ok ok ok ok ok ok

(R
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[Total No. of Questions-9]

Time Allowed: 3 Hours

B.Ed. Semester-ll Examination
B.Ed.-13/10/23

Knowledge and Curriculum
Course Code: BED-201
(2022-24)

Minimum Pass Marks: 24

Note: i) Attempt five questions in all, selecting one question from each

1.

4.
o

unit. Question No. 1 is compulsory.
i) All the questions carry equal marks.
Write note on each of the following in about 50-75 words:
a) Characteristics of Knowledge.
b) Education for nationalism.
c) Meaning of community-centered curriculum.

d) Textbook as an indicator of effective curriculum construction.

(3,3,3,3)
UNIT-I

Explain the different sources of knowledge in detail. (12)

Explain the role of teacher in the construction of knowledge. Give six

Barriers in the fransaction of knowledge. (6,6)
UNIT-II
Define education. What are the characteristics of education? (3,9)

What is meant by values? Explain the different types of values. (4,8)

[Total No. of Printed Pages-2]

Maximum ‘Jarks: 60



UNIT-HI

Define curriculum. Explain the components and principles of curriculum
construction. (2,5,5)
What are the different factors responsible for curriculum change? Explain

With the help of appropriate examples. (9,3)
UNIT-IV

Explain the curriculum development model given by Hilda Taba. Give its
Advantages and limitations. (8,4)

Discuss the role of teacher in knowledge construction through feedback as

a critica| pedagogue. (12)
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8/30/23, 11:32 AM Social Science Quiz

Social Science Quiz

Unit 2 {2.1}
{Concept of curriculum, core-curriculum and hidden curriculum principles of
curriculum development in social science}

MCQ's

The respondent's email (2201007.dhawani@miercollege.in) was recorded on submission of this form.

Amanpreet kaur *

Dhawani sharma

2201005 *

2201007

Unit 2 {2.1}
{Concept of curriculum, core-curriculum and hidden curriculum principles of
curriculum development in social science}

MCQ'S

https://docs.google.com/forms/d/1 TwbwiMTSRIE4PMZFCgvwvinaVe9QhNIMS5jRsHEVVWDI/edit#response=ACYDBNhIGUXSPol6 TM-2fWzN2fq3l-G...  1/36



8/30/23, 11:32 AM Sacial Science Quiz

Component of curriculum is: * 1 point

Teaching strategies
Objectives

@ Evaluation
All of the above

Option 5

Curriculum is supposed to: * 1 point

Be organized by the school
@ Achieve the objective
Both (a) and (b)

None of the above

The importance of curriculum in the system of education is just like a: * 1 point

Preparation of students for service
@ Constitution in a country
Provision of latest knowledge

None of the above

https://docs.google.com/forms/d/17wbwiMT5RIE4APMZFCgvwvtnaVe9QhNIMSjRsHEVVWDI/edit#response=ACYDBNhIGUxSPol6 TM-2fWzN2fq3l-G... 2/36



8/30/23, 11:32 AM Social Science Quiz

Major concern of curriculum is: * 1 point

Change in individuals behavior
(® Preparation for service
Personal satisfaction

None of the above

Psychological foundation play its role in the development of curriculum keeping in * 1 point
view the:

Student's needs
Student’s Interest
Student’s capabilities

(® Allof the above

Psychological foundation play its role in the development of curriculum keeping in * 1 point
view the:

Student’s needs
Student’s Interest
Student'’s capabilities

@ All of the above

https://docs.google.com/forms/d/17wbwiMT5RIE4PMZFCgvwvinaVe9QhNIMS5jRSHEVVWDV edit#response=ACYDBNhIGUxSPol6 TM-2fWzN2fq3l-G... 3/36



8/30/23, 11:32 AM Social Science Quiz

The arrangement of the elements of curriculum can be can as: * 1 point

Curriculum Design
Curriculum Foundation
Curriculum Construction

@® Curriculum Development

1 point

Transmission of norms, values and beliefs conveyed in the classroom atmosphere is -

core curriculum
content curriculum
(® interdisciplinary curriculum

hidden curriculum

1 point
The curriculum model that has deductive,linear and prescriptive approach is -

Hilda Taba Model

Ralph W. Tyler

Fisher Model

@ none of the above

https://docs.google.com/forms/d/17wbwifMT5RIE4PMZFCgvwvtnaVe9QhNIM5jRsHEVVWD editiresponse=ACYDBNhIGUxSPol6 TM-2fWzN2fq3l-G... 4/36



8/30/23, 11:32 AM Social Science Quiz

* 1 point

It is a set of courses that are considered basic and essential for future classwork or
graduation

hidden curriculum
core curriculum
@ decentralised curriclum

centralised curriculum

It includes content, learning experiences and learning activities- * 1 point

Syllabus
@ curriculum
assignments

assessments

1 point
Curriculum based on thinking of John Dewey is
(® learner centred curriculum

activity centred curriculum

subject centred curriculum

None of these

https://docs.google.com/forms/d/17wbwiMT:! SRIE4APMZFCgvwvinaVe9QhNIMSjRsHEVVWODI/edit#tresponse=ACYDBNhIGUxSPol6 TM-2fWzN2fq3l-G...  5/36



8/30/23, 11:32 AM Social Science Quiz

Broad field curriculum is a modification of; * 1 point

Activity centred curriculum
Learner centred curriculum
Subject centred curriculum

(® None of these

Philosophical foundation of curriculum is concerned with: * 1 point

Ideas
History
Economy

(® Contents

The factors that effect the development of curriculum are called: * 1 point

® Curriculum design
Curriculum evaluation
Foundation of curriculum

Elements of curriculum

This form was created inside of MIER College of Education (Autonomous).

Google Forms

hittps://docs.google.com/forms/d/17wbwiMT5RIE4PMZF CgvwvtnaVe9QhNIMS5jRsHEVVWDI/edit#response=ACYDBNhIGUxSPol6 TM-2fWzN2fq3l-G... 6/36



MIER College of Education (Autonomous)
Accredited by the NAAC with ‘A+’ Grade

CRITERION II
TEACHING LEARNING AND EVALUATION

2.4 Competency and Skill Development

_\

2.4.1 Institution provides opportunities for developing competencies and
skills in different functional areas through specially designed
activities / experiences that include

ot

4.Technology use and Integration




SAMPLE
OF
ICT LESSON



e ————— f——— p— p— — P

o

IDENTIFICATION DATA LE_SSON NO. 3

Name of the Pupil Teacher: (gw Cﬂw,u-u\““
Sehool: ___ pMpoled Atadery

Class ﬂﬁ“ Sectlond Subject: &Zmuf &%
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Time Duration: Lfo THE e Date | l@, 2024
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MINIATURE TEACHING AIDS
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" IDENTIFICATION DATA

Name: Sonia Chaudhary
Roll No: 2201001




Why do we
fall ill??

CONTENT

‘ v’ Introduction
| v’ Concept of Health
v’ Meaning of Disease
v’ Difference between Being Healthy & Disease-free
v Causes of Disease
v Types of Disease
v’ Difference between Infectious and Non-Infectious Diseases
v Evaluation '
v Home Assignment




oY

. Being healthy is a profound privilege we often take for
granted.

"« In our country, a significant number of individuals

- grapple with various health issues, highlighting the
pervasive nature of diseases.

- This topic delves into the intricate dynamies of our
well-being, seeking to understand the factors that
contribute to the prevalence of illness and ultimately
answering a erucial question: Why do we fall ill?

e e A b el ST i, R AT R

» State of proper functioning of body Y-

and mind.
- » Not merely the absence of disease
but a holistic state of thriving.
« Influenced by lifestyle, genetics,
environment and healthcare access.
- Vital for a productive and fulfilling i -~
life. kit YR
According to World Health Organization (WHO)-
“Health is a state of complete physical, mental
and social well-being and not merely an absence

of disease or infirmity.”




PHYSICALLY
FIT

MENTALLY
FIT

» Made up of two words- dis + ease
means disturb the comfort.

» An abnormal condition of an
organism which interrupts the
normal body functions is called a
disease.

» May affect different people in
different ways.

» Gives rise to symptoms and signs.
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Being Healthy

Being Disease — Free

| Itis a state of being — well to function properly
physically, mentally and socially.

It is a state in which there is no discomfort in any
part of the body.

It is determined by the individual as well as social
and environmental factors.

It is entirely up to the individual.

A healthy person will be free of disease.

A disease-free person may or may not be healthy.

A healthy person is energetic and capable of
performing as needed.

A disease-free person's performance depends on

his or her nature and personal attitude.

'CAUSES OF DISEASES.

IMMEDIATE-

. Wia, viruses,
fungi, protozoans, etc.
' Directly responsible for

mfect:ous dtseases

o i S A i

CONTRIBUTORY
* Intrinsic or internal
factors. o

development of diseases.

Qo



57

The diseases are caused due to the following reasons:
» Environmental factors (Climate, Industrial hazards)
» Inadequate diet

> Genetic disorders ~~
» Poor economic conditions
» Infective agents

. . Health cutcomes
R EE T LR

e

| rrerme o e
-

TYPES OF
DISEASES
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ACUTE DISEASES

EZ
Acute Diseases refer to a medical condition that occurs suddenly and lasts for a shorter period of time.
‘ There symptoms are clearly visible in the body.
p
¥
';
!
l

Examples :- Common Cold, Influenza, Typhoid, Cholera, etc.

CHRONIC DISEASES

Chronic Disease refers to a medical condition which lasts for a long period of time and have long - term
effects on our body.

Examples :- Elephantiasis, Cardiovascular Disease, Arthritis, Cancer, Tuberculosis, etc.




INFECTIOUS DISEASES

Infectious Diseases are the diseases caused by various pathogenic microorganisms such as Vi ¥
Bacteria, Protozoan, Fungi, and other Parasites. They are also known as Communicable Disease,
infectious diseases can be transmitted by Animals, Humans, Insects or Other Agents.

Examples are — Malaria, Rabies, Mumps, Influenza, Hepatitis - B, Polio, Dengue, Smallpox,
Elephantiasis, SARS, Measles, Common Cold, Cholera and Tuberculosis.

NON - INFECTIOUS DISEASES ™

Diseases that do not require the presence of an infectious agent to cause disease are called Non- =
Infectious Diseases (also known as Non -~ Communicable Disease). They arise as a result of Internal
Imbalances in our body.

Examples are — Asthma, Allergies, Diabetes, Heart Diseases, Cancer, Arthritis, Epilepsy, Multiple
Sclerosis, Anorexia and Bulimia.




Infectious Diseases

Diseases that spread from one person to
another are called Infectious Diseases.

[NFECTIOUS VS.NON - INFECTIOUS DISEASED

Non - Infectious
Disease

Diseases that do not spread from one
person to another are called Non
Infectious Diseases.

I o

They are caused by microbes called

Pathogens such as Bacteria, Protozoans,
Viruses, etc.

They are also caused by the Pathagens.

Transmission of diseases occurs through
Food etc.

e e TR e AR e
Direct Contact, Alf, vwaiel,

Transmission of diseases occurs from
Parent to Offspring (Hereditary Disease).

Community Hygiene can reduce the risk
and occurrence of Diseases.

Societal Hygiene is ineffective in reducing
. the occurrence of diseases.

Example: Diabetes, Cancer, Allergies, etc.

Example: Cholera, Malaria, Covid - 19

A. Fill in the blanks:
a) Health is a dynamic equilibrium of 5
well-being.
b) Diseases are often characterized by an imbalance in the of the body.
c) factors are also known as intrinsic or internal factors.
d) The difference between being healthy and disease free lies in the

state of an individual.
B. Short answer type questions:
- Q1. State any two conditions essential for good health.
. Q2. What is a disease? State its types.
Q3. Give two examples for each of the following:
2) Acute diseases
b) Chronic diseases
c) Infectious diseases
Q4. Differentiate between being healthy and disease free.

and

<

EPRp———— ]



HOME ASSIGNMENT

“HEALTH SNAPSHOT”
Create a visual collage reflecting your daily health choices (meals, exercise,
screen time, sleep) with short reflective captions. Set two wellness goals for
the week and design a simple daily tracker to monitor your progress. Submit
a picture of your health snapshot and share insights gained.

o
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{5 | ) MIER Collége of Education (Autonomous)

College with Potential for Excellence Status by the UGC

' Recognised by the J&K Govt. & Permanently Affiliated to the University of Jammu

Accredited by the NAAC with ‘A+* Grade

OBSERVATION SCHEDULE
(To be filled in by Group Supervisors)
Ratings
=) ko g B
S. No. Components 5 E g E g
B < B>
L. Clarity of Language .
2. Variety in Interaction N
3. Formulation of Instructional Objectives -
4. | Delivery: Presentation e L2 = R
Delivery: Confidence i
Delivery: Understanding B
Delivery: Board Writing o
5. Appropriateness of Pacing ol
6. Pupil Participation 4
7. Closing of the Lesson

*H.C.-Highly Confident, C.-Confident, A-Average, L.C.-Least Confident.

Observer’s Remarks:
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Signature of Supervisor



SAMPLE
OF
SESSIONAL WORK



T/ MIER COLLEGE OF EDUCATION (AUTONOMOUS)
Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu
Accredited by NAAC with ‘A+’ Grade

]

2.4.1 Institution provides opportunities for developing competencies and skills in
different functional areas through specially designed activities / experiences that

include:

4, Technology use and Integration

« B . 1 1055 X % PR o e
I’ 5] 3570 ge a8
" n L] & D (=] »

= ¥ Classroom » Course 105 Sem:i, Session 2022-2024. Methodology of Teaching s 3

Stream Peopie

Mid-Term Re-test online Quiz ,Course 105, Se...

. Mid-Term Re-test anline Quiz .Course 105...

Mid-Term online Quiz Course 105 (Methodolo...

Mid-Term online Quiz Course 106 (Metho..

Sessional Work of Course Code 105, Methodol...

TENDASNTER 5. Meth...

Academic activities for students conducted through Google Classroom

Iv B uresgredinmionaiss X B sessions

d € ¢ &3 ciassicomgoogiecom/c/NTAINDYyMz
B fh logintathe ste B8 855 Sem Wl Sessa @ CrasciT » [

— ~ urse 105

= |B Classroom » -°u=e'® 3

Studernt work
Opoints  + @
O @ 01 Smiile 10 sharma Bamotra
& iale :
]
1=] G 02 Bhavys Gupta S
fessional ethics . pdf Adcbe Scan 12-Jan-2

Submission of Sessional work by students in Google Classroom.
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Workshop on using Mendely for reference writing for the students



Connect to Wi-Fi » , You are signed in as fyotisha

. First nam T 4 1 1 1
£ /last name  Emall address State on Ce § tak Grade/1 <
1%
SHRUT . 8
& March
BHASIN 3 | mins
imiercoliegein  |Finished 2024549 |, 10.00 v v
940 |PM =
) SBCS
DIVIHYA = g
March |16 March
KA i - 2 mins
miercoliegen |Finished | 2024 3 9.00 u’ s
825 “
bl
M secs
Priya Gupt March
n
progress

Students working on Moodle



Use of Technology by student in Seminar presentation

Use of Technology by student in presenting ICT lesson



Digital Skills enhancement of students through workshop



Students being trained on using QUIZZIZ app
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Archived

B.Ed spl 2022-24

B.Ed 2022-24

Bhavya

INTERNSHIP GROUP 1 (2022-...

FYUP (2023-27) B.A Honours
M @ Photo

FYUP (2022-26) B.A. Honours

Vonika: &3 |

BA Psych.Hons 21-24
onika: @ Photo

Orientation on MOOCs for the students




MIER COLLEGE OF EDUCATION (Autonomous)

Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu
Accredited by the NAAC with ‘A+’ Grade

SCHOOL OF EDUCATION
SESSIONAL WORK

COURSE NO. MED-204

(INNOVATIVE USE OF TECHNOLOGY IN
RESEARCH)

NAME: Sonia Chaudhary
ROLL NO: 2201001
SEMESTER: II
SESSION: 2022-24

TEACHER IN-CHARGE: Dr. Mool Ra; \\\\\
J /;' \\7‘



Sessional Work (All compulsory)
D. Creating record of the below mentioned activities in the form of a Digital/Print File along with

reflection/blog/portfolio on each activity;

a) Google Classroom Setup

b) Online Teaching on other platforms

c) Data Entry in Excel/ Google Sheets and Basic Statistical Computation
d) SPSS Setup and Usage

e) References and Mendeley Usage

f) Development of one MOOC

E. EVALUATION

The distribution of marks for the course is as under:

(a) Sessional Work

1) Google Classroom Setup and Online Teaching

2) Data Entry in Excel/Google Sheets and Basic Statistics Calculations:
3) SPSS setup and Usage

4) References and Mendeley Usage

5) Development of MOOCs

(b) ICT Based Quiz

1. Google Classroom Setup
STEPS OF CREATING GOOGLE CLASSROOM AS A TEACHER

STEP 1: Search Google for Education on the web or enter URL- edu.google.com/ and
then click on sign in. Now simply go to google class.

Google for Education ,. Mo CoogheWorkimcs for Edkacation

M D & 0 ;e @

Products that
power education

Google for Education tools work together to transform
teaching and learning so that every student and
educator can pursue their personal potential

Get started with Google Workspace for Education




Goagle for Education

===

MDD O D oOoRG@

Products that
power educahon

Google for Education tools work together to transfo

teaching and learning so that e

educator can pursue their personal potential

Get started with Google Workspace for Education

STEP 2: This will prompt us to log in to our google account.

Use your Google Account

-

Forgot email?

Not your computer? Use Guest made fo sign in privately

Learn more

Create account




STEP 3:Once we've logged in, we will see the Google Classroom page.

= B Classroom e 138 T
Home 7
Calendar

Daon't see your classes?
Try another account

&8 OB

Archived classes ]
Settings
'
N é

-

Add a class to get started

ety m

STEP 4: Click on the “+” sign in the top right corner and select “Create class.”Fill in the
details (class name, section,etc) and click “Create.”

= GougleClassroom i e
.:_—] o [ To revien L-J e Create tlass

MED & MA -20150ci... | MED-202 Historical, o ! MAE-202(2021-22) S ¢ MAE-203 Statistical .

Or Bindu, 100 12 1.0 pm , Session 2. : M Sayka Sanc 930 10 1010, Session Sem 8 10.20am-11 D0sm Meg Ruoni Prof. Adit, 900 to %:50sm, Session, 20..
| ‘9

MED/203 MAE/204 (2. @' MEd.204, Innovative. " T MAE-206, Computer . 8 MED-207 Science Ed... i+

Mrz. Ruchiia sharma, 12.10pm-12.50 Dr Mocd, 110101200, M.Ed 204, 207 Er Rajan, Fin, Set, Sexsion 2000 22 i e Neshta, 1020 = 11.00 am, Seasgn




Create class
a35 hame (recure
Test Classroom

MEd Sem It

Google Classroom

Online

STEP 5: Now Test Classroom 1 is formed and | received an invitation as a teacher from
Dr. Moolraj Sharma.

Dr. Mool Raj invited you to teach now
Test Classroom 1 (2022-24) - Accept invite

STEP 6: Then | accepted the invitation from sir.Up until now,| was looking at the Stream
section of the Google Classroom, now it was time to move to a different tab. There were
four tabs that were noticed in the top portion of the screen: Stream, Classwork, People,

and Grades. | Clicked on the People tab.

Stream Classwork People




STEP 7: On the People page, we can see two sections, one is to invite other teachers
and the other is to invite students. In the teachers section, we have to click on the profile
icon on the right side of it to proceed to extend the invitation to other students in my
class, inviting them to join as teachers in the online google classroom.

Invite teachers

Sandeep Kour
2201012 sandeep@amiercollege ir

07 Dhawan: Sharma
2201007 dhawar@mie

Anchal Mahajan
2201010 anchal@mierc

Divya Jyoti
2201008 divya@rmiercollege. in

R I,

STEP 8: Half of the students are enrolled as teachers in Test Classroom 1.Finally
Google Classroom has been made as a teacher.

TAaaasAT
BN CLdliCon e S iz oy )
G ome Stream Cizsswork Pacpie Grades [ T e S 1]
[ Calendar
Q.
App— Teachers 2
E Toreview
& Dr. Mool Raj
o Test Classroom 1(2022-24)
‘ Ot Sonia Chaudhary

~ ©n  Enrolled
E Yo-do Et Amanpreet Kaur

MED-207 Science Educati

Dt Mishta Rana 10 S0em 0a ‘ Dinesh Singh
° Test Classroom 2 (2022-24)

el S e Nikita Verma
° MED/203 (2022-24) . Pre-s.
0 MED-202, 2022-24 . Nitasha Penarvisg
a M.Ed 204, Innovative Use a Sonika Devi

D Mol 1280812 45 M £ 204
0 MOOC/s MED Semester Il View less
o MED-201 Sociological Pers. L ®

STEP 9: Similarly,click on the profile icon on the right side of the Student section to
invite students. So | invited my student.



Students o

Invite students or give them the class code: 4n262ck

STEP 10: A window will pop-up, asking us to add students. Enter their email ids in the
recipient box and then click on Invite.

Invite students

Invite link

hitps Zelassroom google com
Type a name or email

Sandeep Kour

2201012.sandeep@miercoliege.in
Ishang Sharma

2101016.ishang@miercollege.in

20020

09. sonia@miercollege.in

Bharti Tandon
bhari.tandon@miercollege.in

% 09 Sonia Chaudhary

Cancel

STEP 11: The invitation was sent to Roll no. 7, my student. s



Students

Stream

View less

i Dhawani Sharma (invited)

=l

Classwork

People

There we go! The Student will now be able to join my classroom and keep up with the
coursework. Now | can begin assigning classwork to her.

STEPS OF CREATING CONTENT FOR GOOGLE CLASSROOM

STREAM

STEP 1: The Classwork tab comes into play for content creation. There are three major
aspects to content creation on the Classwork page: Create, Google Calendar, and

Class Drive folder.

Stream

Assign work to your class here

@ Create assignments and questions

fE Use topics to organise classwork into modules or units

't& Order work the way you want students to see it

Classwork Pecple Marks /

[} Google Calendar [*] Class Drive folder




STEP 2: Create-The Create button will give formats that you can use to set your content

Assignment
here

+
H]]
=

Quiz assignment

(4]

Question into modules or units

Material dents to see it

(AR Y

Reuse post

i

Topic

ASSIGNMENT CREATED

STEP 3:Now | assigned the essay type test first to my student, Dhwani.

For
Essay type test 1 student -
et foprang Points
Write a brief biodata
.0 -
Due

Sun, Jul 30, 11:59PM
D Close submissions after due date
Drive file =
A 0 T Topic
Unknown File
2201001 Sonia

Rubric

Attach
+ Rubric

47 (<o)
o o l' A [ Check plagiarism (originality)

Drive YouTube Create Upload Link

X [ Assignment m

o}




B Classroom > |

Home

Calendar

e

Essay type test

00000000 Q@ »

Teaching

10 paints Due Jul 30, 11:59PM
To review
Test Classrcom 1{2022-24) Write a brel biodata
Drive file
- Enrolled Unknown Fite
To-do

MED-207 Science Educati. o
| € 2, Class comments

m 2 (2022-24) t
2-24) . Pre-s..

Test Class:

MED-202, 2022-24

M.Ed.204, Innovative Use .

MOOC/s MED Semester Il

MED-201Sociclogical Pars...

@ Sonia Chaudhary posted a new assignment: Essay type test } 1 student
Jul18

STEP4: The assignment was submitted by her and then graded by me.

instructions Student work

= 10 points -

O e All students Essay type test

Sort by status \ 2 O O 1

Tumed Assigned Graded

[[] Graded & Accepting submissions (O

D a 07 Dhawani Sharma & All " ()
n 07 Dhawani

Sharma

07 Dhawani Sharma -




QUIZ CREATED

STEP 5: After assignment, | created a quiz for my student.

Quiz on social change

Kindly complete the quiz

Biank Quiz

Attach

Drive YouTube  Create Upload

& o - L e

Tue, Oct 31

4  cClose submissions after due date

Topic

2201001 Som
Rut

$ Rubric

[ check plagiarism (onginality)

®

STEP 6: The quiz was assigned.

Instructions Student work

Quiz on social change.

Soma Chaudhary + 1

20 points
Kindly complete the quiz

Blank Quiz

nttps://forms.gle/icSB1

oy s
2, Class comments

Due Oct 31




STEP 7: The student completed and handed in the quiz assigned. Then it was graded.

(| 20 points )
O e All students %
07 Dhawani Sharma 20/20
Sort by status -
[[] Graded
O n 07 Dhawani Sharma 20
2, 1private comment
t Sonia Chaudhary 123P
well done
i . ,
MATERIAL UPLOADED
STEP 8:Then | uploaded a material (ppt) on Raja Ram Mohan Roy.
@ Material on the work done by Raja Ram Mohan
roy.
Sonia Chaudbary - 1:30PM
Kindly go through the ppt
e )
af Raja Ram Mchan Roy.pptx
“ bese ssassSst PowerPaint
22 Class comments
®
@

REUSE POST

STEP 9: | reused the post of one of the teachers in the classroom.

Y




& Select post (Test Classroom 1(2022-24) + MEd Sem Il Group1)

Title Teacher Post date

|I| Observation as a tool of Data Collection '& Amanpreet Kaur Jul21

E] NAI TALIM Nikita Verma Jul
EI Explain the concept of modernisation? Nikita Verma Jul 21

E] Essay type test.

g asha Pangotra Jul 20
Write a brief bio-data. itas 9 a

E'-] quiz Sonika Devi Jul1¢

Essay type test F 1
B Write a brief biodsta Sonia Chaudhary Jul 18

Quizz0 " ;
E" Quizz . Amanpreet Kaur Draft
z

[] create new copies of all attachments

Instructions Student work

Explain the concept of modernization? :

Sonia Chaudhary * 1:55PM
10 peints . Due Oct 31

Kindly write the answer in detail.

2, Class comments

t Add class comment

STEP 10: The answer was graded by me as a teacher.




Explain the concept of modernization?

n 07 Dhawani Sharma 9/10 -

# Roll no. 7 Dhawani .pdf Openwith +
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ONLINE TEACHING ~

Step 1: Open the zoom desktop app on your computer.

Files

=

= Roll no. 7 Dhawani .p.

Grade

Private comments

‘ Sonia Chaudhary

Written well

1B

B B Add a csbendar

01:45

Thursday, November 2

Respond to events. create booking links. and
more by ting you

Today ¢ F >

Host: Sonia Chaudhary ~




Step 2: Go to the “Meetings” option on the top. Your personal meeting id

and link will be shown.

m_

Upcaming

360 110 2091

My Personal Meeting 1D (PMI

My Personal Meeting ID (PMI)

01:51

Thursday, Novernber 2

Respond to events, create booking finks. and
more by connecting your calenda

Today « @ >

Host: Sonia Chaudhary ~

No meetings scheduled
Enjoy your day!

Step 3: Just copy the invitation as a teacher and send it to the mail of the

student.

Passcode 54Xg0T

« Reply

B ® @ B DO

= M Gmail Porel T
D <
&= & Compose A @0 ®
it
ien:

o & inbox Science class
STy ‘ Sonia Chaudhary «220/001 =
= ® Sncozed 8

> Sent
o [ Orafts

v More

Labels +

Meaeting ID 360 110 2091

r* Forward

Step 4: The student joined the meeting and taught-her online.




Wishhaali

Firstname Lastname Email Duration Time joined Time exited
01 Sonia  Chaudhary 2201001.sonia@miercollege.in 8min  1212PM  12:20PM
Sonika Devi 2201002.sonika@miercollege.in 8min  12112PM  12:20PM
Divya Jyoti 2201008 divya@miercollege.in 6min  1214PM  12:20PM

Amanpreet Kaur 2201005.amanpreet@miercollege.in 8min  12:12PM  12:20PM
Sandeep  Kour 2201012 .sandeep@miercollege.in  8min  12:12PM  12:20PM
Anchal Mahajan  2201010.anchal@miercollege.in 8min  12211PM  12:20PM
Nitasha Pangotra  2201006.nitasha@miercollege.in 8§min  12211PM  12:20PM
Dr. Mool  Raj moolraj.sharma@miercollege.in 9min  1211PM  12:20PM
07 Dhawani Sharma  2201007.dhawani@miercollegein  9min  1211PM  12:20PM
Divya Sharma  2201013.divya@miercollege.in 8min— 1212PM  12:20PM
Vishali Sharma  2201011.vishali@miercollege.in 8min  12:12PM  12:20PM
Dinesh Singh 2201004.dinesh@miercollege.in 8min  1212PM  12:20PM
Nikita Verma 2201003.nikita@miercollege<in 8min  12:12PM  12:20PM




USING GOOGLE CLASSROOM AS A STUDENT

Completed assignment

= B Classroom ?

Q Your answer Classmate answers

sz e e e

D e All students
Ca
3 Sonia Chaudhary

Test Classroom 2 (2022-24)

What do you mean by technology? Give a brief description

t Sonia Chaudhary

and systems that facilizate the

2. expertise and methods that humans use 1o

38 and innovation in mogdern society, iIMpacting

various aspects of life, from communication and trans

& Reply

Read the material uploaded by the teacher

@ Educational studies

B Dhawani Sharma + Jul 21
r & Educational studies ppt

Educational studies.pdf

PDF
0] 2, Class comments

t Add ela

Completed the quiz also.



REFLECTION

I, Sonia Chaudhary, a student of M.ED sem-Il having roll no. 2201001
wants to reflect on the process of setting up Google Classroom and online
teaching. On 6 July2023, Dr.Mool Raj Sharma, our teacher in-charge,
oriented us about the syllabus of Course code- 204 “INNOVATIVE USE OF
TECHNOLOGY IN RESEARCH?”. Then he continued the first unit- “Google
classroom as a teaching and learning tool” from the next day i.e on 7
July,2023.After learning this unit, | am filled with a sense of accomplishment
and a new found knowledge. As a future teacher, | have learned the
intricacies of creating a digital classroom environment, from sending
invitations to students to assigning various forms of work. Understanding
how to manage and grade online work has been a valuable skill that I've
acquired. Moreover the ability to conduct online classes through zoom and
google meet, sharing screens, recording lessons and attendance has
streamlined my professional development. In the role of student, | delved
into the world of Google classroom from a different perspective. | learned
to navigate assignments, quizzes, and materials with ease gaining a deeper
understanding of the platform’s capabilities.Now | am equipped with a
powerful tool that enhances my teaching methodology and enables an
interactive learning experience. Looking ahead, | envision integrating this
learning into the various facets of my teaching journey. From creating
lessons to providing timely feedback, Google classroom will serve as a
cornerstone of my instructional approach.The adaptability and versatility of
online teaching using google classroom, zoom, google meet, webex have
opened up exciting possibilities for my future lesson planning and delivery.
In conclusion, this experience has been transformative, equipping me with
a valuable set of skills and tools that |“would undoubtedly use in my
teaching approach in the digital age. Special thanks to my teacher for
supporting and guiding me in this journey.



2)_Data Entry in Excel/Google Sheets and Basic
Statistics _Calculations

i) Making of Google form

Step 1:Go to forms.google.com.Click Blank Plus and name your untitled
form.

=B Q —— ] o

H—
\/\
€ C & docsgoogle.com/inms/di TTeprZTiofychFOXV_FTWDIByWZ TptS9T ValoYid/edt 2 % %0 1‘ ‘
E Untitledform [ % 40ohenges e 0 ® 9 2 m g t
Questions  Responses  Settings

" ik it ®

Critical Thinking Questionnaire 3

Tr

]

Untitled Question o

Option 1 =]

Step 2: Add questions
Open a form in Google Forms.Click Add Add question.To the right of the question title,
choose the type of question you want.Type the possible responses to your question. To



prevent people from not answering, turn on Required.

€ C @ docsgooglecom/formsid/ Hbesiht ’ z z Viyma4 t CER I T | 1‘ i
a Critical Thinking Questionnaire [ ¥ 8 6 @ 9 e m H '
Questions  Rasponsas e Settings
—

" 2 s : ; ®
Critical Thinking Questionnaire o
The following is a list of 5 slatements. Please rate on a scale of 1 1o 5 to what extent you agree with the given Tr
statement that applies to you
[
&
Name *
=
=
Roll No
Programme
B.A. Political Science
B.A. Psychology (2]
€ C @ docsgooglecomsioms/d/ I6esdMRukvACRaa0Y2kNSbiToH_JzpydPXY = o % 0 ? H

E Critical Thinking Questionnaire [J ¢ e e o m 5 t

GQuestions  Responses a Settings

1. After reading anything, | check important information, even it seems to be true.

[t}

1 2 3 4 5
Tr
Strongly Disagree Strongly Agree
)
Gl
2. 1like combining information from different texts. =
1 2 3 4 5
Strongly Disagree Strengly Agree

3.1am willing to share the newly gained information.

Strongly Disagree / trongly Agree




Step 3: Then | shorten the link of the google form, copied it and sent it to my professor
for evidence and the students to fill the form.

Send form

Collect email addresses Do nol collect -

Send via 8 n u

Email
1 Dr. Mool Raj X Entar names or

Critical Thinking Questionnaire

I've invited you to fill out a form:

D Include form in email

2+ Add editor Cancel Send

Send form

Collect email addresses Da not collect ¥

Send via ™ n u

Link

hitps//forms.gle/WyvbFyqiXpBPFRIga9
Shorten URL

Cancel Copy

Step 4: After that, the students filled the questionnaire-and | collected the data from

them.



C & docsgooglecomic BesaMFuk 2a0rY2kX5bitoH 22 v editdreso @ R OP i

e Critical Thinking Questionnaire [ % e ey e m : t

Questions  Responses ° Settings

6 responses
Summary Question Individual
Name
& responses
Tanisha
Vishah

Gagandeep kour

Amanpreet Kaur

Sonika Rana

Sunaina Sandhu

7]
Step 5: The spreadsheet was made from the collected data by clicking on “View in
sheets”.
& 2 O & docsgooglecomispreadshests/d/105b4ayuZ:vbvaghaPOUOK3aDOSRTHZK Hereditresourcakevioi= 027056631 2 x &0 v :
Critical Thinking Questionnaire (Responses) & 0 & Q § (- e t
Fle Edt View Insert Format Dafa Tools Extensions Help
QAo QG0 § 340 0w Jefaur.."-ilﬂi+EI%i¢'Hi Evivh-Aro P YRS b
Al v fr Timestamp
A B ¢ D v £ ; K !
P ——
1 Timestamp | Name Roll No. Programme Sex 1. After reading anythng, 2.1 ike combining inform 3. | am wiling to share th 4. n-depéh analysis of re:5. The same confes
2 10262025 11:03:40 Tanisha 20 BA English Female 2 3 1 2
] 10262023 11:04:43 Vishal 20101 MEd. Female 4 4 4 3
J 10262023 11:15:28 Gagandeep kour 191 BA. English Female 1 3 3 2
10262023 11:27:44 Amanpreet Kaur 201005 MEd. Female 5 § B 4
10262023 11:37.29 Sonka Rana 201002 MEd. Femdle e 5 5 4
2 /
o
/
P




ii) MAKING OF SURVEY MONKEY

Step 1: Enter URL surveymonkey.com. The survey monkey site will open.

€« > C % surveymonkey.com

r & W O P E

™% SurveyMonkey Products v Templates v Pricin g Enterprise  Resources v £} ContactSates Login Sign up free

Are my employees happy at|

A global leader in survey software. 20 million questions answered daily

Who is vour survey audience?

D e

Step 2: | signed up by entering my college mail and | chose the option to
start the basic plan.

<« C @ suth-us.surveymonkey.com
Y ¥

2 & ® 5O

& SurveyMonkey

Already have an account? Log in

Create an account

Email address

2201001.s0nia@miercollege.in

Or sign up with

®#0 m G e

Help Termsof Use Privacy Notice CaliforniaPrivacy Notice Cookies Policy Do Not Sell My Personal information Cockie Preferences

Step 3: | selected the option- “Build it for 'me""'"l after clicking on my target
audience as students and goal as “School Evaluation”.

rd
S



€ 2> C & surveymonkey.com/cre

h Home Plans & Pricing

Create a new survey Copy a past survey

¢] Start from scratch

Recent
2, Buy Targeted Responses
High School
Student...
¢h Copy a past survey
All
Import Questions
L
(5] Start from template Hign Schog
Student...

O Build it for me

“ ¥ Feyorites

Upgrade l Creata survey

Type your title
here

Type your title
here

Step 4: Design survey can be clicked and | was able to edit,options, move

,copy, library, delete.

reotoecs | @ |

High School Student Feedback Survey [ o |

SUMMARY  DESIGNSURVEY  PREVIEW&SCORE  COLLECTRESPONSES  ANALYZERESULTS  PRESENT RESULTS m

ﬁ STYLE Fageloge » Mces Actions w
Build

SETTINGS THEMES @ Loc0
Style
High School Student Feedback Survey

&

LOE'IC @ Lreate custom theme

4 | EOT  OPTIONS  MOVE  COPY
Options —

Text

A BUTAATHDGE » »
Question Heritage 0 i 7 : Ak o T . - & & -

Bank . .

sPlease take this survey to share your experiences at school,

; @ et tetfrom_ ¥ i

E Simple

Format i

| Hickname
o i o

Paid Full Color |

Features |
./ 2
High e
5 eseall | " (eancee |
| CT
/

Step 5:Then the survey questions ( Total 10) were made which | could

/

/



preview in various forms by clicking one of the three options below in the
left corner.

SUMMARY DESIGN SURVEY PREVIEW & SCORE COLLECT RESPONSES AMNALYZE RESULTS PRESENT RESULTS ﬂ F-4 A“n‘hﬂm NEXT >

SURVEYMONKEY GENIUS

O No issues %

High School Student
ESTIMATED COMPLETION RATE Feedback Su rvey

78 % Completed

ESTIMATED TIME TO COMPLETE

3 Minutes Please take this survey to share
your experiences at school. (O GENIUS ASSISTANT
et’s get creative—add a iogo 10 your
© toco 1. How much do you

enjoy going to school?

() Agreat deal

(U Alot

{ ) Amoderate amount

% - — =
Device view [ @ Q o R L survey Format o =3 [F] O

Step 5: At last, | needed to send this survey to all the students for collecting
data by clicking on the “Collect and respondes option” and share the survey
link or send it by mail.

{5 C & surveymonkey.com 1/ a0 FalsoDeelnmiz4uut f lafGdL NghvGvekZg 3 6w ¥ EHO f i

{* Home  Plans&Pricing

High School Student Feedback Survey n

SUMMARY DESIGN SURVEY PREVIEW & SCORE COLLECT RESPONSES ANALYZE RESULTS PRESENT RESULTS

Recommended ways to send your survey

59 Share a survey link 4 send by email UPGRADE

Other ways to send
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Step 6: Lastly, we can analyze and present the results from the data
collected by clicking on the options “Analyze results” and “Present results”.

iii) DATA ENTRY INTO EXCEL AND STATISTICAL CALCULATIONS

DONE
Step 1: First of all, | started entering the data into the excel form.

},‘ ’ P - * [a _‘Ehws"m' Ay )

e | BT WS (ETE R 5 5 ElMegeacume < Do % 0 7| ool femam GO |l Dserome | 00 S fs | md

Cipboard 5 ront & Abgaenest [ Nursber [ saves et tsing Add s k

A B C D E F G H I J K L M N =

1 S.No. NAME Science  Hindi History  English  Maths Total
2 1 Kaushal 81
3 2 Amit 97
4 3 Montu 68
) 4 Prashant 43
6 5 Sonia 52
7 6 Sonika 76
8 7 Aman
9 8 Nikita
10 9 Vishali
1 10 Sunil
12 11 Raja
13 12 Abhishek
14 13 Harleen
15 14 Tanisha
16 15 Sunali
17
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Step 2: Then codes for gender and residential address were entered as shown and all
the marks for all subjects were entered.

'5:' Cason - A X = B- i wapten Geners . E P 0 | S e [ | S s Ay O
¢ fort o | @ 1 = s chd L R oo Rl e e 3 e
P 5 p i rlt i g 5 o A
D E F G H J K L M
6
7
8 Code for Gender Code for address
9 Male 1 Urban 1
10 Female 2 Rural
1
12
13
14
15
16
17 '
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Q  Teil me what you want 1o do

o X on Calib " A A = 2+ Bwaoten Genera | 3 4 | E= 2K i ZAvpin. ¢ A Ol e
B Copy ~ L v - ; T Hll~ , |
Pt i | B T U+ B f- A 00 W Evwkcon - (% 1 WA | oo ey DL e Wb e o S T T A
Chpboard [ fort () Eignment [ Nurmber [ Styles Cells Editing Add-ins
A B G D E F G H | J K L M =

1 S.No. NAME Gender Residential Address History  English ~ Maths Hindi  Science

2 1 Kaushal 1 1 50 65 67 56 81

3 2 Amit 1 1 60.5 88 83 87 97

4 3 Montu 1 2 65 56 38 43 68

5 4 Prashant 1 2 74.5 97 97 88 43

6 5 Sonia 2 2 34 34 64 24 52

7 6 Sonika 2 1 54 70 63 87 76

8 7 Aman 2 1 86 85 42 90 48

9 8 Nikita 2 1 92 44 62 65 69

10 9 Vishali 2 1 76 74 76 73 74

11 10 Sunil 1 2 99 73 87 82 81

12 11 Raja 1 1 32 89 87 83 85

13 12 Abhishek 1 2 43 94 87 98 98

14 13 Harleen 2 2 29 93 6 89 55

15 14 Tanisha 2 1 87 91 54 98 87

16 15 Sunali 2 2 66 82 90 56 88
17
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Step 3: Now the basic statistical calculations were done such as the following:
AUTOSUM

By clicking on the “Autosum” option from the formula, the total of marks of all the

subjects were made from the first row i.e from E2 : 12 by 2 ways. First is to enter “=Sum

(E2:12) and second is to directly choose the Sum option from Autosum.

=

AT B ERBDB R O B ) i shom ot —)

Insert  AutoSum Recently financial Logreal  Text Date & Lookup & Mahé  More Name Sy i EnorChecking > e | Caicularion T Calcitane Shwet
Function - Used = v - ©  Time~ Reference = Trig~ Functions~ | Manager 5 Create from Sefection o Arrows Wingow | Options ~

Punction Library Dafwed Narires Formuia Sudtng Catcutation
E2 £ |50 -
A B C D E F G H 1 J K L M =

1 S.No. NAME Gender Residential Address History English Maths Hindi Science Total

2 1 Kaushal 1 1 50 65 67 56 81 4 319

3 2 Amit 1 b 60.5 88 83 87 97

4 3 Montu 1 2 65 56 38 43 68

L 4 Prashant 1 2 74.5 97 o7 88 43

6 5 Sonia 2 2 34 34 64 24 52

7 6 Sonika 2 1 54 70 63 87 76

8 7, Aman 2 1 86 85 42 90 48

9 8 Nikita 2 1 92 44 62 65 69

10 9 Vishali 2 1 76 74 76 73 74
11 10 Sunil ak 2 a9 73 87 82 81
12 p i Raja 1 1 32 89 87 83 85

13 12 Abhishek 8 3 2 43 94 87 98 98

14 13 Harleen 2 2 29 93 6 89 55

15 14 Tanisha 2 1 87 91 54 98 87

16 15 Sunali 2 2 66 82 90 56 88
17
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Then the cell of the Autosum answer was dragged below till | wanted the sum.

A > B ER e | Rt Vo e | B Wi
Funchon Ubrary Defoved Names Formula Auding Caladaton ~
A B C D E F G H I J K L M c
1 S.No. NAME Gender Residential Address History English  Maths Hindi  Science Total
2 1 Kaushal 1 1 Y 50 65 67 56 81 " 319
3 2 Amit 1 1 60.5 88 83 87 97 " 4155
4 3 Montu 1 2 65 56 38 43 68 270
5 4 Prashant 1 2 74.5 97 97 88 43 7 3995
6 5  Sonia 2 2 34 34 64 24 52 208
7 6  Sonika 2 1 54 70 63 87 76 7 350
8 7  Aman 2 1 86 85 42 90 a8 7 351
9 8  Nikita 2 1 92 44 62 65 69 332
10 9  Vishali 2 1 76 74 76 73 74 " 373
1M1 10 Sunil 1 2 99 73 87 82 81 7 a2
12 11 Raja 1 1 32 89 87 83 85 " 376
13 12 Abhishek 1 2 43 94 87 98 8 " 42
14 13 Harleen 2 2 29 93 6 89 55 7 272
15 14  Tanisha 2 1 87 91 54 o8 g7 7 417
16 15  Sunali 2 2 66 82 90 56 88 " 382
17
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MEAN / AVERAGE

Now the Mean was used to calculate the average of the selected data. It
can be done in 2 ways: First is to type “ =AVERAGE (E2: 12) i.e from 1st
cell address to 2nd and drag below and second is to select the average
option in the Autosum.

A 2 H B | 2 B o =

71 Calewiate Now
h::::“ AuroSum R«e'v? h"l"k_‘ ¥ Lou_‘u- ':.u DT_;A R:r:::;'h_ l::‘ig\_& ‘“nk:““ i 4 Calcutate Shear
L Sk s Facpaia saig i
> o
A 8 C D E F G H I J K L ™M =
1 S.No. NAME Gender Residential Address History English Maths Hindi Science Total
2 1 Kaushal 5. 1 50 65 67 56 s1 " 319 =AVERAGE(E2:12)
3 2 Amit 1 1 60.5 88 83 87 o7 -5 a155
4 3 Montu 1 2 65 56 38 43 68 I 270
5 4 Prashant 1 2 74.5 97 97 88 a3 " 3005
6 5 Sonia 2 2 34 34 64 24 52 " 208
7 6 Sonika 2 1 54 70 63 87 76 7 350
8 7 Aman 2 1 86 85 42 90 ag " 351
) 8 Nikita 2 1 92 a4 62 65 69 332
10 9 Vishali 2 1 76 74 76 73 74 7 373
1 10 Sunil 1 2 99 73 87 82 g1 422
12 11 Raja 1 1 32 89 87 83 85 376
13 12 Abhishek 1 3 43 94 87 a8 98 -~ 420
14 13 Harleen 2 2 29 93 6 89 85 7 272
15 14 Tanisha 2 1 87 91 54 98 87 7 417
16 15 Sunali 2 2 66 82 20 56 88 " 382
17 b
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o ! Hemr Hielp

3 i 13 Trace Precedants Py Show Formulas — = Calculate Now
,f-‘ z ﬂ =) Iﬂ |E: ﬂ { L! ‘.ﬁ gl e L s = Caleulate N
Insert AutoSum Recently Financial Logical Text Date & Lookup & Math & More Name L Watich Calculate Sheet
Function - Used ~ - = ~  Time~ Reference ~ Trig~ Functions~ | Manager (= Create fiom Selecuon 5 Remove Aiows ~ (A ETvaluate Formula  wyindow | Options
Funcnon Library Cefined Namas Formda Audibing Cabcudation
(841 - !
A B C D E F G H I J K L M
1 S.No. NAME Gender Residential Address History  English Maths Hindi Science Total Mean
2 1 Kaushal 1 1 50 65 67 56 81 319" 638
3 2 Amit 1 1 60.5 88 83 87 97 " 4155”7 831
4 3 Montu 1 2 65 56 38 43 68 270" 54
5 4 Prashant 1 2 74.5 97 97 88 43 " 3995" 790
6 5  Sonia 2 2 34 34 64 24 52 " 208" 416
7 6  Sonika 2 1 54 70 63 87 76 350" 70
8 7 Aman 2 1 86 85 a2 90 ag " 351" 702
) 8  Nikita 2 1 92 a4 62 65 60 332" 66.4
10 9 Vishali 2 1 76 74 76 73 74 " 373" 746
1 10 Sunil 1 2 99 73 87 82 g1 422" 8aa
12 11 Raja 1 1 32 89 87 83 85 376"  75.2
13 12 Abhishek 1 9 43 94 87 98 98 420" 84
14 13 Harleen 2 2 29 93 6 89 55 S 272 § 54.4
15 14  Tanisha 2 1 87 91 54 98 87 417" 834
16 15  Sunali 2 2 66 82 90 56 8s 3827 76.4
17
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PERCENTAGE

The percentage can be calculated by entering “=Marks obtained/Total
marks* 100" i.e cell address “=J2/500*100.

I = BE B o= 5 Carcuare Now
a;':."on AutoSum r::::l; Financial Loq-w(al Text Eia::. u::-?n:?- h::w;-:l iu':xz::“ D (54 Calculate Sheet
Fundlion Library Defined Narnes Formula Auditing Calauistion
2 - b v fi 12/500°100 b
A B C D E F G H I J K L M b
1 S.No. NAME Gender Residential Address History  English Maths Hindi Science Total Mean
2 1 Kaushal 1 1 50 65 67 56 a1 - % 319”7  63.8 =J2/500*100
3 2 Amit 1 1 60.5 88 83 87 97 " a155" 831
4 3 Montu 1 2 65 56 38 43 68 270" 54
B 4 Prashant 1 2 74.5 97 97 88 43 " 3995”799
6 5  Sonia 2 2 34 34 64 24 B2 208" 416
7 6  Sonika 2 1 54 70 63 87 76 350" 70
8 7 Aman 2 ] 86 85 a2 90 ag " SE1F TN 999
9 8  Nikita 2 1 92 a4 62 65 69 332" 66.4
10 9 Vishali 3 1 76 74 76 73 74 " 373" 746
11 10 Sunil 1 2 99 73 87 82 81 422" 844
12 11 Raja 1 1 32 89 87 83 a5y 1 aze’  75.2
13 12 Abhishek 1 2 43 94 87 98 98 " 420" 84
14 13 Harleen 2 2 29 93 6 89 B50 .1 272" s44
15 14 Tanisha 2 1 87 91 54 98 g7 " 417" 834
16 15 Sunali 2 2 66 82 90 56 g8 382" 764
17
- Sheet!  Sheat2 3 . = o
Emer O Accessitaty: inve f ol

Then clicking on enter and dragging it below.
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A > B & BEE R @ oo ot ) f s
ann | R B e arsaee= Taoe e | Minsger ) Crase rom Setection | 16 Remerve v @) Evaniate Forrmss | woinsiw | Griioes . P CUoAUE Sheet
ikl ey pl e i 3

Mil4 b 1a/s00 00 -

A B c D E F G H I J K L M 2
1 S.No. NAME Gender Residential Address History  English Maths Hindi Science Total Mean Total marksPercentage
2 1 Kaushal T 1 50 65 67 56 81 3197 638 500 63.8
3 57 Amit 1 1 60.5 88 83 87 97 r 415.5’ 83.1 500 83.1
4 3 Montu 1 2 65 56 38 43 68 270" 54 500 54
5 4 Prashant 1 2 74.5 97 97 88 43 39957  79.9 500 79.9
6 5  Sonia 2 2 34 34 64 24 52 208" 416 500 41.6
7 6  Sonika 2 1 54 70 63 87 7% 350" 70 500 70
8 7  Aman ) 1 86 85 a2 90 as " 3517 702 s00 70.2
9 8  Nikita 2 1 92 a4 62 65 69 7 332" 66.4 500 66.4
10 9 Vishali 2 1 76 74 76 73 74 " 373" 746  so0 74.6
11 10 Sunil 1 2 99 73 87 82 81 422" 844  s00 84.4
12 11 Raja 1 1 32 89 87 83 85 7 376" 752 500 75.2
13 12 Abhishek 1 2 43 94 87 98 98 4 420' 84 500 84
14 13 Harleen 2 2 29 93 6 89 55 " 272" 544 spo 54.4
15 14 Tanisha 2 1 87 91 54 98 87, 417" 834  s00 83.4
16 15  Sunali 2 2 66 82 90 56 88 382" 764 500 76.4
17
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REFLECTION

Engaging in the process of data entry and statistical calculation through
platforms like Excel, Google Sheets, and collecting data from tools like
Google Forms and SurveyMonkey has been an illuminating journey.This
topic was started and taught on 9 Oct,2023. Upon understanding and
practically doing all this, | find myself not only equipped with new skills but
also motivated by the vast potential these tools offer.

First and foremost, learning how to effectively collect and manage data
through Google Forms and Survey Monkey has been a pivotal skill. The
ability to craft insightful questionnaires and quizzes, and subsequently
compile responses into organized spreadsheets, has streamlined the data
collection process. This knowledge has significantly enhanced my
proficiency in conducting surveys and extracting meaningful insights from
the gathered data. It will be very beneficial for me in my research work
afterwards. Furthermore, delving into the intricacies of data entry in Excel
has provided me with the possibilities. Understanding functions like
AutoSum, mean, average, and the creation of visual representations
through bar graphs and pie charts has fortified my analytical capabilities.
These skills not only facilitate accurate data representation but also lay the

A



foundation for informed decision-making. Looking ahead, | see this learning
vital for my future endeavors. The proficiency gained in data entry and
basic statistics will undoubtedly play a vital role in various aspects of my
professional life. Whether it's conducting research, analyzing trends, or
presenting data-driven insights, these skills will be valuable. As a result of
this learning, | feel a confidence in my ability to handle and interpret data
effectively. The process of data entry, once an intimidating task, now feels
like second nature. It permeates into my overall approach to
problem-solving and decision-making.

In conclusion, this journey into data entry and basic statistics has not only
broadened my skill set but has also instilled in me a sense of confidence
and motivation. | look forward to applying these newfound capabilities in
practical scenarios, knowing that they will be instrumental in driving
informed and data-backed decisions.

3) SPSS setup and Usage

Steps to Download and install the trial version of SPSS from its website.

Step 1: Type IBM SPSS statistics trial in google.lt opened and | clicked on
the first option.

IBM SPSS software

Bridge the gap between data science and data
understanding i L% g

Buy SPSS Statistics now = —> Try SF Modeler =

Why IBM SPSS
software?

€ 3 C & bmeomisn G2 v B S0P




Step 2: | scrolled down and clicked on “Try SPSS statistics at no cost” and
entered my details for signing in.

€ 5 C & ibmcom G w v B SOP
Take the next step

Discover how you can uncover data insights that solve business and research problems

Related products

Try SPSS Statistics at nocost =
Next steps

{ Let'stalk B0

IBM SPSS Statistics Create an IBMid
Start your 30-day trial Sressle geean L ey

unt? Lo

4 Account information ~

V\'/' Test the full capabilities of SPSS Statistics

This trial contains all SPSS Statistics add-ons

Sign in with Linkedin
AutoF il your information

purchase through ¢

Get clear insights from your data
Plan, collect, analyze and report data all in one product with

SPSS Statistics. 2201001.sona@miercoliege.in °

Easy open-source integration
Turbocharge your research with an extensive and Hexible range

ption, term and perp

Sonia Chaudhary

India v Jammu and Kashmir ~




Step 3: | got a code for activating my IBMid in my mail.So | had to enter it'

for verification.

= M Gmail
€D
[ & Compose
Mai
3 & inbox 37
fr Starred
2 @ Snoozed
B Sent
(a] ) Drafts
v  More
Labels .

0o @ 8 0 @« ® ©°

New User Registration (#isss

IBM Security
IBMid Confirmation code

Use this code to activate your IBMid:

6871315

-> Copy this code

- Return to the sign-up form.

- Paste it into the form.

for 30 min

ites

14
Tiv

@ Active

©)

©

(OJ
: B

g
Q

Step 4:After verification, registration was successful.A mail was received

again mentioning successful registration.

- M Gmail

# Compose

Inbox =1

r O -{-ra

Starred
Snoozed
Sent

Drafts

Do
« DV Ee=» DO

More

Labels +

=h in mail

B 0 @ B 0 & @m D

— IBM SPSS$ Statistics Subscription Trial

Below are your subscription details.

IBM SPSS Statistics Subscription Trial

ASR Expiration Date
November 26, 2023

Duration
30 cays

Start date
October 27, 2023

End date
November 26, 2023

Customer Account
Seonia Chaudhary’s Company

Get started —

® Active ~

@

8

= e
= Sezus

Step 5: Now | clicked on the get started option and | was taken to the

download option for my PC.l downloaded it and-it was ready to install.




c

& myibmibmecom

My [BM

My prbd ucts

I @ Displaying filtered list of products.
Trials

S

IBM SPSS Statistics
Subscription Trial

e

Installing TBM SPSS Statistics

The program features you selected are being installed
it

take several minutes.

Status:

Copying nevy files

Please wait while the InstaliShield Wizard installs IBM SPSS Statistics. This may

InstallsShield

Step 6: Further, | logged into the IBM account by entering my email and
password. '

Cancel

il




Log in toIBM

2201001 .sonia@miercollege.in

Step 7: At last, | opened the SPSS software and it appeared like this below.

@
Ele Edt View Data Jranstom Analyze Graphs Uiidies Extensons YWndow Help

TS B v~ BLEITER AEBE= {9 n ]

Visible: 0 of 0 Vanabled

Ovzrasw  Data View Variable View

IBM SPSS Statistics Processor is ready Unicode ON sssic [l

Screenshots showing installation, working, and steps of analyzing data
Example- Measures of Central Tendency, SD, Correlation, t-test, F-Test



(ANOVA), Reliability, etc. and creating SPSS output file, importing results,

and interpretation of results

COMPUTATION OF FREQUENCIES

Step 1: Go to File>Open>Data either from SPSS file itself or Excel sheet.

) Untitiea [DataSet0] - SPSS Data Editor

File Edit View Data Transform Analyze Graphs Utilities
New > - FHk R
Open > Data...
Open Datab[ﬂ}g > Syntax...
Read Text Data.. Output..
Script...
Other...

Rename Dataset...

Display Data File Information >

Cache Data...

top Proce

Switch Server...

Prnt Pr

Prn

Recently Used Data » , .

Recently Used Files » e 1 - e

Window Help

@

Values

Missing I Columnsl Align I Measure

Data Jransorm Analyze Graphs [Ridies Extensions Yindow telp

2
Look jn 23 Excel

< Book1xdsx

A 5
&

IR T Y

) [§] [

Visible 0 of  Vadables

-@mEmEsE

Filas of ype

Ouercew  Data View Vanable View

Data

Excel " xis " xlsx

* xism)

JBMEPSS Statistics Processor 15 ready 4 Unicode ON - ]




Step 2:

The data from excel sheet has been imported into the SPSS format.

<

Overeen  Data View

Vanable View

[5]
Ee Edt View Data Transhom Analyze Graphs Uuities Extensions Window Help
' —— - .
HE W Th=F A BT 4
Visible 13 of 13 Vanablas
S5  JaMNAME g Gender 3 Resicentaia # Histoy & Engiish & Maths # Hing & Saence & Tolal #uean P Toaimas Percentage
adress
1 1 Kaushal 1 1 65 7 56 81 538 -
2 2 Amat 1 1 38 L 87 97 831
3 nlu 1 2 58 3 43 549
4 4 Prashant 1 2 97 97 83 799
5 2 2 Er ) &4 4 418
8 g 2 1 70 63 87 76
7 7 Aman 2 1 85 42 2 48
a 8 Maila 2 1 44 62 65 60
9 2 1 74 7% n
10 1 2 73 B7 a
1 1 1 a8 a7 a
12 1 2 L 87 8
13 13 Hareen 2 2 93 L] &
14 14 Tansha 1 a9 54 % a7
15 15 Sunall 2 2 B2 20 56 38

Step 3: Go to Analyze option>Descriptive Statistics>Frequencies. Now copy
and move the data with the play button to the right side and press ok.

F

Fie Edt View Deta

Translorm  Analyze

Grapghs  Lhiites

Extensions  YWindow  Help

We~TLIE AR SQ0R

[ Cregte APA style tables

$She  GHNAE  § Gender Y Resigentats & History & Engish & Maths & Hngi & scence & Toul # Uean  F Totaimanis & Percentage
> déress
1 1 Kzushal 1 1 500 85 87 500 iy
2 2 Amdt 1 1 505 ] 83
3 3 Monty 1 2 850 ®
4 4 Prashant 1 2 745 a7
5 & Sonia 2z 2 40 34 B4
& & Somwa H 1 540 ™
7 7 Aman 2 1 860
] B i z 1 920
9 ¢ Vishak 2 1 760
10 16 S 1 2 20
" 11 Raja 1 1 20
1z 12 Abhishex 1 2 40
13 13 Harieen 2 2 290
14 14 Tanisha 2 1 870
18 15 Sunail 2 2 560
A Dispiay wrequency tables

Visible: 11 of 13 Variables




Transform  jnsed  Format  Analyze  Graphs  Usfines  Extensions  Yyndow  Help
- % = - X ey
Mrise B o E8 LW JC]CEEE
| * Frequencies
DataSeti|
Statistics
1! € " Jams T Waa 3 matk
xa 15 15 15 15 15 15 113 15 15 15 15 15 15
[ ] 0 0 ] 0 2 [ [ ] ] ] [ 2
Frequency Table
S.No.
v T 67 57 57
1. 2 1 7 87 113
] 1 7 67 00
1 87 67 267
5 1 67 87 na
5 1 87 67 400
7 1 .34 67 ®7
8 1 57 67 533
» 1 67 &7 800
10 1 a7 67 667
13 1 &7 67 733
1 ! 67 67 800
1 &7 a1 87
| 14 1 67 67 933
| 15 [ a7 67 1000
T 15 100.0 1000
¢ » NAME

Step 4: The frequency tables
exported to the word form in

are obtained from the given data and it is now
word by clicking File>Export.

Daf“ ¢ st | B oL My e X X - AT  E- e A AL Ik Hegim ) e i Swede S Eptpes Select~
chighoard ) Font ] Paragraph @‘ Styles ] Edting
NAME
Frequenc
¥ Percent
Abtushek 1 817 8.7 87
T Aman 1 67 67 133
Amid 1 6.7 67 200
Harlaen 1 87 6.7 267
Kaushal 1 6.7 67 333
Montu 1 67 6.7 400
Nikta 1 6.7 8.7 46.7
Prashant 1 67 67 533
Raja 1 67 87 600
Sonia 1 67 6.7 6.7
Sonika 1 67 87 73
Sunall 1 67 87 800
Sund 1 67 6.7 867
Tarsha 1 67 67 033
Vishal 1 67 67 100.0
Total 15 1000 1000
Gender
Fraquenc Vaid Cum
¥ Percent  Percent
Vaid 1 7 467 467 57
2 8 533 533 1000
Total 15 100.0 100.0




COMPUTATION OF T-test

Step 1: Go to Analyze>Compare means and proportions>Independent
samples T-test.Then a pop up box will open. Just Add Science in the upper
right box through the play button and Two independent samples i.e gender
(Define it as male and female).Click on OK.

a
Fie Edt View Qata Jransform Analyze Graphs Utities Exiensions Yindow Heip
o - —— y & s o e s
HE Ne~FTELIT AR 4 Wl |
22 Hstory Misible: 13 of 13 Varabies
@SHe  GNAE @ Genom Resentain & Hawn P Engisn g Mams Prea  Pocece P Tom Prsan P Tomans P Pecentage
aaress
1 ' 1 a0 5 " 538
2 1 505 = 87 7 a1
3 1 2 5.0 58 38 4 ] 2 540
: ) 2 745 97 87 8 3 95 ™9
s ‘a
s 2 -
L £ ] 4 Test Variabiels)
x £ 1 ! @S He [SNoj & Scunce
9 2 Pl NAME
10 2 { @ Residertial Addrsss [Residantial
" ' 5 : -
' g i
12 t 2 ‘& Englsh
1 z 2 i g Maths
1 2 ) 1 =
e 1 ';” e Groupng Varable
Telat » | Gendent 2)
# Maan
& Total marrs [Totsimarics]
& Prrcertage
g [ Estrmate offect sizss
Oversew Dot View  Variable View
B4 SPSS Statistics Procassor is reacy 4 Unicods ON | Classc [

Step 2: Now an output file will open.The whole calculations and result will
open on theT-test.
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Ede E™ View [Data Jeansiorm  fased  Formal  Anshyze (Geaghs  Uiibes Extensons  Yfndow  Help
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Group Statistics
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a
I
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COMPUTATION OF CORRELATION

Step 1: Go to Analyze>Correlate>Bi-variate. Then choose the variables

among which we need to determine the correlation i.e pearson correlation.

B8] sata sheetsay [DataSetl] - 5755 Data Edito [} x
File Edit Viea Dasta Transform Analyze Graphs Utilities Window Help
| £ [ 4 = [ Reponts »
Hame Type SRECIPUVE AALRELs g I Values Rhissing ] Columns I Algn Measure _I e AR
1[Sihio Numenc Tables 2 Maone None [ Right Scale
2| Rna Mumanc Compare Means » "None Mone '8 .R:gm Scale
3| Coltege Stng General Linear Mode! » Mone MNona 4 Left Nanunal
4] Sex Numernc Mixed Models > {1 Famale} None 's >Rvgﬂl Nonunal
5 | PrevQualifi | Numenc 3 Correlate > Shrmiate; :B ‘R-gm Nomnal
6 | teachingsu | Numenc Hegrestion 'y Berthals |8 Right Nomunal
7| STUCOH1 | Numenc 8 Right Nominal
8] sc2 Numenc Logloesr A etancas, '8 "Right Mominal
9] sc3 Mumeric Classity > Mone tone 8 = Fugnt Nominat
10| sc4 Numeric Data Reduction > Mone None L] [Right |Nomunal
11} sc& Mumeric Scale » Mone Mone 8 jR<gl|( Ef‘lulnml
12| sc6 Numenc Nonparametric Tests None Nona .8 _|Right Im:nnmal
13 sc? Mumernc Time Series . Mone MNone | B8 _R:gn! Mominal
14 | sc8 Numernc HMone MNona 8 Right Namunal
15| TEASUP1 | Numenc Sthvheat Mone None I [Rignt Hominal
16| 1s2 MNumeric Multiple Response 4 MNone MNone 8 [Right MNonunal
17)1s3 MNumenc Missing Value Analysis.. "MNone Nong 8 [ Right MNaminal
18 | 1s4 Mumeric Complex Samples > ' Mone None I8 fRagm Nomunal
13| 155 Numeric L v (185 HNone Mona 's i'R.ugm tomnal
20 | ts6 Numernc 11 ilJ tsh  Hane Mona _3 'Fbghl Nominal ]
21]1s7 Numeric 11 |0 ts7 Mone MNone : ] | Rught Nominal
22118 Numenc 211 0 ts8 | :B [nghl |Mominal y
23 | INVOL1 MNumerc 11 0 INVOL1 '8 [ Right Nominal .
<7 T TR 1T TR T RN | T [ 8 ight ominal
25[in3___ | Nu & 0 TRE 8
26 | ind 0 ind 8
e ] [ R RESE | TR 2 8 3
28 6 [ in6 e
Anl .= ~ S -~ hd
L3
f i Vie Dats Transform Analyz Grapt
e R o =P & I~ HET. @
Hame Type | Width ] Decimals [ Labal ] Values Missing 1 Culun!nal Align Measure | =
1 [Sitio Numenc KK 10 iS(l-Ju Hone MNona 8 Rignt Scata
2| Rno Numenc | |8 ’R»gm Scala
3| College Stang 4 Laft tNominal
4] Sex Numeric 2 PvS_A [Pivs_Al Vanabien — 8 Right Norminal
5 | PrevQualifi | Numenc o Pe’_B [PrevS_B) & didertConesceness .8 |Right MNominal
5] teachingsu|Numenc | | g Povs A Puavd Al 8 Teacher Suowot Towc - LR 8 Right  |Nominal I
71 STUCOH1 | Mumenc & Pavi Pavd] TR Reset '8 [Rignt Mominal
8]sc2 Mumernc & Stresm |Sream] c 8 Right Nominal
9] sc3 Mumenc S Con Nean [Snd I} :R;ghl MNonunal
10 sca Mumerc e Heip '8 | Right MNonmunal
1] scé Numeric '8 |Right Nominal
12] sc6 Numaeric SR Caafficiets I [Right Nominal
13] sc? Numenc | EJPesson [rendafstevt [ ]Soesman T8 |Right  |Neownal |
14| sc8 Numenc Tew of Sgrdcance '8 Right Nominal
15 | TEASUP1 | Numenc @) Two tated ~) Ore-Laled 8 Right tomunal
16 | 1s2 MNumernc o k] -Rrgm Nominal
17| ts3 Numerc (4 Rag mgréficart comelatons '8 iRngm |Normnal
18 | ts4 MNumernc T L TTOTE TVOTTE 8 Right |Nomunal
19[ts5 Humenc 1 0 [Mone Nona I8 |Right Nominal
20| 155 Numeric 1 0 "Mone Nona I Right HNominal
21 |s? Numenc :11 0 tone Mone :3 Right Nominal
22188 Numenc ' 0 :Nuna None ‘8 ¥ Right Nominal
SIRVOLT  fhewerte BV QB R, 2 gL T 0 R
24 Jn2 Numernc |11 0 8 Right Nominal |
3 ] o 8
a. -
8
8




&8 B E Ok @ &
QR
E'] Output | (DacaSecl] D:\DeskBack-4-4-17\Moccl Raj\Resesarch'\Research others\Monika Basas Data Calcul
Correlatons
- Title
Notes
L[ Active Dataset Descriptive Statistics
Ly Descriptive Statistd
(@ Correiations Mean Std_Dewvation i}
StudentCohesneness 330315 429589 317
Teacher Support 27 2934 572185 317
Correlations
Studgent
Coheswe Teacher
ness Support
StudentCohesiveness  Pearson Correlation 1 3is4*
SigQ. (2-taileq) 000
N 317 317
Teacher Support Pearson Correlation 3841 1
Sig. (2-1ailed) 000
N 317 317
**_ Cofrelation is significant at the 0 01 level (2-tailed)

REFLECTION

The topic “SPSS setup and usage” was taught on 16 October, 2023 by my
teacher. Learning about SPSS setup and usage has been a great experience
for me. | now know how to download and install the trial version of SPSS,
all thanks to the step-by-step guidance provided by my sir Dr.Mool Raj
Sharma. Understanding how to analyze data using measures like central
tendency, standard deviation, correlation, t-test, and f-test has been really
interesting. Creating SPSS output files, bringing in results, and
understanding them has become quite clear to me. This skill not only
helped me analyze data better but also made it easier to get meaningful
information from it. This learning has boosted my confidence in handling
data analysis using SPSS. I'm excited about using this knowledge in the
future. Whether it's for research or making decisions based on data, SPSS
will be a very useful tool. | want to thank my teacher who has been really
patient and supportive. His help and encouragement have made a big
difference in how well | understand and use SPSS. In conclusion, this
experience has given me a valuable skill in data-analysis with SPSS. It's not



just useful for my studies but will also be really important in my future
work.

4) References and Mendeley Usage

Creating an account and sharing a screenshot of my library depicting my
name in Mendeley
Step 1: Go to the Mendeley website (www.mendeley.com).

.m Mendeley

| /. DISCOVERY

Mendeley brings your research to life, so you can make an.impact on tomorrow

Search over 100 million cross-publisher articdes and counting

_ o
dopular searches: COVID-19 Bioenergy Obesity

Step 2: Click on "Create account” and enter your email address.

Signin

Step 3: The main page of mendeley reference management will open.
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Welcome to Mendeley

Search for and add articles to your library

Try the desktop app to manage your library

Support
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Download Mendeley Reference Manager

Mendeley Supports Responsible Sharing

3 Learn how you can share

About Us Downloads

Step 4: Search for and add articles to your library. Then a library will be
formed as a reference repository.Click on library option and see all the

saved references.

€ 3 € @ mendeleycom/referc managar/b 6 & v T & 0O ’ £
+Add e All References Q Se =i
AUTHORS YEAR nME SOURCE ADDED + FLE
Al References
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Recently Read . Chodak K, Ciesieiski P, G 2023 Digital Un y: A Study of Students’ Experrences and Expectations in the Pos. Education Sciences 005
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. Bannykh G. Kostina S 2022 DIGITAL UNIVERSITY: APPROACHES TO THE CONCEPT DEFINITION Obraz 00.56
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+ W AKanaanH 2022 Awareness Regarding the Implication of Artificial Inteligence in Science Educatl...  Intemational Joum 20/08/2023




Creating 10 References in APA (7th Edition) Style using Mendeley and
submit the Word file here.

Step 1: Open Mendeley library and click on the option “Tools"”.Then click on
“Install Mendeley cite for Microsoft word”.

GROUPS

now"
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Overview
Cite as te. Generate citations and bibliographies and change your citation style.
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B Microsoft
soniachaudhary3009@outlook.com

We're updating our terms

As part of our effort to improve your experience
across our consumer services, we're updating the
Microsoft Services Agreement. We want to take this
opportunity to notify you about this update.

Learn more

Signout TermsofUse  Privacy & Cookies

Step 3: Mendeley cite was downloaded and it was ready to open in word
now.

2" Microsoft I Office Store Add-ins  Templates  Support All Microsoft ~  Search O

Mendeley Cite

-LSEVIER LIMITE

Get started with the add-in:

This add-in works in: Word on iPad. Word 2016 or later on Windows, Word 2016 or later on
Mac, Word on the web

If you don't have the above, ty using Office Online.

Can't find the add-in within Office

Enable editing. trust the add-in look for the add-in in the insert tab under ‘My Add-ins

slep instruclions

73 Need more help

Step 4: The mendeley cite has been added to the word.
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Step 5: Now the references can be added in the word file by clicking on the
“References” option and going to insert references from Mendeley.

[ Paragraph

(=] Mendeley Cite

Launch the add-in

After you install the add-in. you ¢an launch it by choosing the add-in button on the

References tab

On the References tab

Need more help?
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Step 6: At last, | created 10 references in APA style 7th edition in it.

{Ali & Anwar, 2011; Delavande & Zafar, 2019; Ferrante, 2012; Konwar, 2017;: Omar et al., 2012; Paris,
2004; Peytcheva-Forsyth et al., 2018; Preti & Tosi, 1976; Smidt et al., 2014; Week, 2016)

Ali, Z., & Anwar, 1. (2011). www.econstor.eu.

Delavande, A., & Zafar, B. (2019). Gender discrimination and social identity: Evidence from urban
Pakistan. Economic Development and Cultural Change, 68(1), 1-40
https://doi.org/10.1086/700555

Ferrante, A. (2012). A CASE STUDY OF INCLUSION AND Charmaine Agius Ferrante.

Konwar, H. (2017). A Study on Attitude of College Students towards E-learning with Special Reference
to North Lakhimpur of Lakhimpur District, Assam. International Journal of Information Science
and Education, 4(1), 1—9. http://www.ripublication.com

Omar, N. D. @, Hassan, H., & Atan, H. (2012). Student Engagement in Online Learning: Learners
Attitude Toward E-Mentoring. Procedia - Social and Behavioral Sciences, 67(November 2011),
464—-475. https://doi.org/10.1016/j.sbspro.2012.11.351

Paris, P. G. (2004). E-learning: A study on secondary students’ attitudes towards Online Web Assisted
Learning. International Education Journal, 5{1), 98—112.

Peytchewva-Forsyth, R., Yovkowva, B., & Aleksieva, L. (2018). Factors affecting students” attitudes
towards online learning - The case of Sofia University. AIP Conference Proceedings,
2048 (December). https://dei.org/10.1063/1.5082043

Preti, C., & Tosi, G. (1976). Preparation, magnetic and spectral studies of some transition metal
complexes of benzoxazole-2-thione. Journal of Inorganic and Nuclear Chemistry, 38(6),
1125-1129. https://doi.org/10.1016/0022-1902(76)80233-3

Smidt, E., Bunk, J., McGrory, B., Li, R, & Gatenby. T. (2014). Student Attitudes about Distance
Education: Focusing on Context and Effective Practices. JAFOR Journal of Education, 2(1), A0—64.
https://doi.org/10.22492/ije.2.1.02

Week, S. (2016). Celebration Activities.

Name — Sonia Chaudhary
Roll.no — 2201001

Style — APA 7' edition

REFLECTION

The topic “References and Mendeley usage” was started and taught from
19 September 2023. Exploring the world of references and learning to
utilize Mendeley has been a significant milestone in my academic journey.
Under the guidance of my teacher, | grasped the essential steps of creating
an account on the Mendeley website and building a library of references. |
also came to know what references are and how they are written in APA 7th
edition format. This process not only familiarized me with a valuable
research tool but also provided me with a structured approach to
organizing and accessing reference materials. Through hands-on practice, |
successfully created 10 references in the APA 7th edition style, seamlessly
integrating Mendeley with Microsoft Word. The ability to effortlessly
incorporate references into my documents has not only streamlined my
writing process but has also ensured accuracy and adherence to citation
guidelines. Looking ahead, | am enthusiastic about the long-term benefits



of this knowledge. As a future educator, this skill set will serve as a
cornerstone of my teaching. It will empower me to guide students in
effective research practices and equip them with the tools necessary for
scholarly pursuits. | am particularly grateful for the unwavering support and
guidance provided by my teacher throughout this learning journey. Their
patient assistance and clear instructions have been instrumental in my
understanding and proficiency with Mendeley. My teacher’s dedication to
my growth as a student is a testament to his commitment to nurturing
academic excellence. In conclusion, this experience has not only enhanced
my ability to navigate and utilize Mendeley but has also equipped me with a
valuable skill set that will resonate throughout my academic and
professional endeavors. | am excited about the future applications of this
knowledge and look forward to sharing it with the students | will have the
privilege of teaching.

5) Development of MOOCs

DEVELOPMENT OF MOOC ON CANVAS

Step 1: Create a canvas account by entering the URL-
canvas.instructure.com.lt will open the canvas.

2T Heed a Cavas Aco 'zmi
Gt CANVAS Click Here. it's Free!

Browse courses
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Step 2: Click on “Need a canvas account” and fill in the details.

YES, YOU CANVAS

Use Canvas For Create Your Account

Wani to see Canvas in action? Get a «
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Sania Chaudhary
A Canvas Free-for-Teacher account has the essential
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(4 Personalize learning with Mastery Paths, “School / Organization
Outcomes, and standards-based gradebooks MIER COLLEGE OF EDUCATION

Y Leverage the Canvas mobile app suite “Why Canvas?

Step 3: Click on submit.
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CREATING CONTENT ON CANVAS INSTRUCTURE

Step 1: Create an image of the topic from wordsart.com and then add it in

the image box by going to Courses>Course details. Also add other details.
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Introduction

Welcome to your exploration of values. their types. and sources in this session. Today promises to be an enlightening experience where we'll defve into the intricacies
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TYPES OF VALUES

=According to Milton Rokeach:

* Goals that individuals
would like to achieve
during their lifetime.

* Also referred to as. ‘the
end state of existence’
« Examples-Comfortable life,
Family security, Freaedom
JEquality ,Self-respect,
Happiness Wisdem,
Salvation ,A Sense of
accomplishment,etc.

~ broadmindedness, courage,

Preferable ways of behaving %
Generally, these values $
show ways an individual
would follow to achieve the
aims in his life.

Also referred to as ‘the
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self-control, ambition,
politeness,

helpful, responsible,
forgiving, ete.
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DEVELOPING MOOC ON MOODLE CLOUD

Step 1: The First step is to enter the URL of moodle cloud i.e.
https://moodlecloud.com. Open MoodleCloud, and Click Try For Free.

ThoodleCloud.

Customer Sign-In

Get Started

Ea e learning experiences, then invite your st

( mysite J O Click
Mt . it in: .' i -TryForFree
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Step 2: Click create a new account.



|ﬁ100dleC|OUd " New to Moodlm

Your Moodle site, ready to go! r - oo
Il Create a new account

Start your 45-day free trial

edt card required Already have a MoodleCloud site?
| activities Log in to add this free tnial site to your account

Step 3: Click on the tabs and fill in the required details.Then scroll down
and click the site name text bar.https:/sonia0101.moodlecloud.com

€ C  # moodledoud.com/app/en/s G o
FnoodleCloud.
Your site Your plan
Free trial
L B
® s age
®
FL will be hitps//sonia0101.moodlecioud com
v
% v
erver region @
Australia 44 Teaching students v
Your details
. Fir <
Sonia Chaudhary

v

e
Step 4: After filling all the details, click “Startﬁe’é trial”.
/,

V&

P

/




Your details

Start free trial -»

ing students

Step 5: That's it. | am done. My moodle cloud account has been created.

fhoodleCloud

heck out the MoodleCloud Quickstart Guide! it

v

Congratulations your site has been
successfully created!

get you started. We've also sent this t

Take me to my Moodle site -

- }:t“'f)i"”-"} f"f_":":.li;:',‘(




* w R I OP O

: L p——
Your site  Home Dashboard My courses Site administration A S B . i inose

Reset page to default

ﬁ Sonia Chaudhary © e
Changes saved x

Email address
201 u Visible to everyone) § report 2 5
Country
India
City/town
fammu
Timezone
Asia/Kolkata Login ac
First access to site

Friday, 3 November 2023, 8:22 PM (8 mins 49 secs)

Last access to site

Content created
Step 1: Went to My courses>New course and created my course * Analysis
of NEP 2020”.
« C @ sonad101.moadlecloud.com/ecurse/edit steg 2w # 50FP:

Category 1

Add a new course

~ General
Course full pame @ @ Analysis of NEP 2020 5 :J
£
o 54
Course short [ X} MEP 2020 _{‘ |
name =J

Course category @ @ x Category 1

Course visibility [2] Show &

Step 2: Then the course was made and a picture was also'added.



€ 3 C i sonalid!moodlecloud comediveci=

Sw RALOP

Your site -ijc—n‘iﬁashma!c My courses - Site administration A S = nv Edit mode
Your site
@able courses
+ Teacher: Soria Chaudhary
€ 3 C @ soniadi0Tmoodlecloud comveours: 2w M L OP
Sonia  Home Dashboard My courses  Site administration L .__ n 9 ditmode @)

Analysis of NEP 2020

> INTRODUCTION ¢

> NEP 2020: Background and recommendations »
> Fulfillment of SDG by NEP 2020 »

> Brief counter arguments »

> Feasibility Analysis »




& @ @ sonia0101 moodlecloud com/mod/page/view phpTid=37Ed0rceview=1

Sonia  Home Dashboard My courses  Site administration AR

NEP 2020 / Introduction

Introduction

Welcome to tiis comprehensive course on the analysis of the National Education Policy 2020. Cver the duration of this
course, we will delve deep into varicus aspects of this transformative policy. We'll starl by understanding the
background and context that led to the formulation of NEP 2020. From there, we'll explore its key recommendations
and how they are paised to reshape the educational landscape in India.

Moving forward, we'll examine how NEP 2020 aligns with and contributes to the Sustainable Development Goals,
underlining its significance in fostering holistic and sustainable development. We'll also conduct a feasibility analysis,
evaluating the practicality and potential challenges of implementing the policy's provisions

To provide a balanced perspective, we'll touch upon counter arguments and critiques that have been raised regarding
NEP 2020. This will enable you to grasp the nuanced discussions surrounding the policy.

By the end of this course, you'll have a comprehensive understanding of NEP 2020, its implications. and its potential to
revolutionize the education system in India. Let's ambark on this enlightening journey together *

Sonia  Home Dashboard My courses Site administration A S

INTRODUCTORY VIDEO




v NEP 2020: Background and recommendations ¢
+

—
FILE } '
| Markas done | §

Original document of NEP 2020 4"

Sonia Home Dashboard My courses Site administration A e T

Haf

1mon:

izing Horizons: NEP 2020 and SDGs

m Harmo

) arcls fulfilling Sustainable development goals

nizing Horizons: NEP 2020 and SDGs

REFLECTION

This topic was started and taught from 4 August 2023.Embarking on the
journey of developing Massive Open Online Courses (MOOCs) using
platforms like Canvas Instructure and MoodleCloud has been an
enlightening experience, made possible through the valuable guidance of
my teacher. His patient and insightful instruction paved the way for me to
grasp the complexities of course crgatidn and content management.
Learning to navigate and utilize /pja‘fforms like Canvas Instructure and

s

F 4



Moodle Cloud has equipped me with a versatile skill set that | can foresee
playing a pivotal role in my future as an educator. Mastering the initial steps
of creating accounts on these platforms laid a solid foundation for course
development. Understanding how to create content and modules has
empowered me to design engaging and structured learning experiences. |
also learned about the ways to create quizzes, assignments, and manage
student enroliment. The knowledge gained in grading and assessing
student work on these platforms ensures a streamlined and efficient
teaching experience. This learning experience, under the guidance of my
teacher, has not only broadened my skill set but has also instilled in me a
sense of confidence in my ability to effectively utilize these platforms for
teaching and course development. Looking ahead, | am excited about the
potential applications of this knowledge. As a future educator, | envision
using these platforms to create dynamic and interactive courses that cater
to diverse learning needs. This proficiency will allow me to provide
engaging learning experiences for my students, whether in a traditional
classroom or in an online setting. In conclusion, this journey into the
development of MOOCs using Canvas Instructure and Moodle Cloud, with
the unwavering support of my teacher, has equipped me with a valuable
skill set. It's not just about using these platforms; it's about leveraging them
to create meaningful and impactful learning experiences. | look forward to
applying this knowledge in my future role as an educator, knowing that it
will enhance the learning journey for my students.

Last but not the least, | want to thank my teacher for his guidance and
support in my journey of learning. | hold him in the highest regard,
cherishing his enjoyable and inspiring lessons that have motivated and
guided me. Sir, your patience and insightful instruction have made a
significant impact on my understanding and proficiency. | feel confident
enough to say that it was a journey filled with self-discovery, motivation and
transformation.| look forward to the opportunities that lie ahead, confident in
my ability to make meaningful contributions to the field of education. | am
truly grateful for the knowledge and skills you have imparted to me. Your
dedication to my growth as a student is deeply appreciated. Thank you for
being an exceptional mentor and shaping my educational path.
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2.4.1 Institution provides opportunities for developing competencies and
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skills in different functional areas through specially designed
activities / experiences that include
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5. Organizing Field Visits
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QF: 100B
DT: 01-12-2023

*#" MIER COLLEGE OF EDUCATION (AUTONOMOUS)
Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu
Accredited by the NAAC with ‘A+’ Grade

ENVIRONMENT UNIT
Session 2023-24

CIRCULAR

This is for the information of all the students of School of Education and School of Social
Sciences and Humanities that the Environment Unit is organizing a visit to Sher-e-Kashmir
University of Agricultural Sciences and Technology (SKUAST) for an enlightening experience
regarding organic farming systems and vermicomposting on 6™ December, 2023. In this regard,
all interested students are instructed to give their name to the undersigned on or before 2™
November, 2023.

P ~

}\I.Ll\- “‘ﬁi———““ K"\ MJ_VJ/
In charge HoD
Environment Unit 7 SSSH

Class Signature

Bf:d SH. Lern T ﬁ .
£A%m T | howess) r]}LL(;L(
ig‘gﬁl fom il /@uw\i/'i

BR Pl (24 %.) i,g;j
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MIER COLLEGE OF EDUCATION (AUTONOMOUS)

Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu
Accredited by the NAAC with Grade ‘A+’

SCHOOL OF EDUCATION

NO: MCE/SOE/2024/261A
DT: 20/01/2024

CIRCULAR

This is for the information of all the students of B.Ed., Semester-l and M.Ed. Semester-1|l that the
college is going to organize a field visit for the course Contemporary India and Education (BDE-104) and
Secondary and Higher Secondary Education: Status, Issues and Concerns (MED-305) to Government
Polytechnic College, Bikram Chowk, Jammu on February 2, 2024 at 09:30 am. All the students are

instructed to report at 9:00 am in the college.

Vbt

Head
School of Education

Copy to:
- Principal, MIER College of Education



MIER COLLEGE OF EDUCATION  fnenuyitiast o e ey f s

é Auton omous Recognised by the UGC under Section 2(f) & 12(B)
; . " +
| Accredited by the NAAC with ‘A" Grade
Ref. No. MIER/MCE/SOE/2024/2¢ s~
Dated: 02-02-2024
The Principal
Govt. Polytechnie College,
Bikram Chowk, Jammu.
; Subjeet: Request for the Visit Related to Vocationalization of Secondary Education and Skill
‘ India on 2" February, 2024 at 10:50 am.
i
Dear Si/Madam
; i hope this letter finds you well. T am writing to express my interest in organising a visit to the
1 prestigious Govt. Polytechnic College, Bikram Chowk, Jammu for the students of B.Ed. Sem. |
| and M.Ed. Sem. I en February 2, 2024, at 10:50 am to orient them about the initiatives
! undertaken by Skill India Schemes and the Vocationalization of secondary education in
it collaboration with the National Skill Development Corporation (NSDC).

A visit 1o vour esteemed istitution would provide hands-on experiences to our B.Ed. and
NMUoEAL students regarding:

I he implementation of Skill India initiatives at the grassroots level.

!he integration of vocational education into the secondary school curriculum and its impact
i on student learning outcomes.

icractions with faculty members and students to understand the pedagogical approaches
and best practices in skill development.

I kindly request your cooperation in facilitating this visit and would appreciate your guidance in
arranging the logistics and scheduling. A list of students is also attached to this email for your
kind perusal.

(s and best wishes,

Prof, Adi ;,«6(

Director & Principal

Warm regs

1 Copy to:
o State Engagement Ofticer, National Skill Development Corporation J&K, Jammu.
¢ Private Secretary & Miss on Director. J&K Skill Development Mission.

B.C. Road Jammu Ph.: 0191-2546078,2565098 Email:principal@miercollege.in

0 b AR g 180 001 Fax:0191-2548239 Website: www.miercollege.in
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Recognized by the Govt, of J&K & Permanently Affiliated to the University of Jammu
Accredited by the NAAC with Grade ‘A+’

QF No. 097B
NO: MCE/24/03/002
Date: 01/03/2024
Smt. Shanti Gupta Centre for Women Studies

CIRCULAR

This is for the information of all concerned that Smt. Shanti Gupta Centre for
Women Studies is organizing a visit to the NIMBARKorganic food plant in Bari
Brahmana, Jammu, for Gender Champions and Club Members to explore the
intricacies of organic farming and entrepreneurship on March 4, 2024.

ngg

Rupa Gupta
Director
SSGCWS

Copy to: (e-mail)

1. Principal
2. HoD PG Department
3. HoDUG Department
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2.4.1 Institution provides opportunities for developing competencies and
skills in different functional areas through specially designed
activities / experiences that include

6. Conducting Outreach/out of classroom Activities




PROGRAMME
SCHEDULE



MIER COLLEGE OF EDUCATION (AUTONOMOUS)
Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu
Accredited by the NAAC with ‘A+” Grade

Environment Unit

PROGRAMME SCHEDULE
Date: 17-02-2024

Time: 11.00 a.m. to 12.30 p.m.
Venue: College Campus
Event: - Healthy Practices related to Environment

Topic: - Waste Segregation and Composting

S.No | Program Time

1. Waste Segregation (A small Skit by college 1la.m. to 11.15a.m.
students)

2 Disposal of Waste in Collaboration with IMC | 11.15 to 11.30a.m

3s Composting (Activity by the students regarding | 11.35 a.m. to 12p.m.
Eco-Friendly Compost Creation and gardening)

4. Pictures of other healthy practices ( Rain Water | 12 p.m. to 12.30 p.m.
harvesting, No use of plastic in Canteen, Solar
lights and Star Rating A.Cs)

Videography of the whole program will be done
: L’LW“GL%LW
" %zchar'ge —

Environment Unit



MIER COLLEGE OF EDUCATION (AUTONOMOQOUS)

Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu
Accredited by the NAAC with grade “A+’

SESSION 2022-23
Games & Sports Unit
Programme Schedule

Date-22/11/2023

Time- 12.30 pm to 2.00 pm

Sports Activity- Interdepartmental Tug of War Match for Bovys and Girls

on 22" November, (2023)

Welcome Ms. Shivani Chib (B.Ed. Spl. Sem.-III)
Declare the Meet Open HODs
SOE & SSSH
Conduct of Sports Activities Mr. Imran

Vote of Thanks

Ms. Ridham Sharma (Student of B.Ed.)

Mr. C.R. Jangra
(In charge Games and Sports)

.
| (=8
HOD

School of Social Sciences and Humanities
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2.4.1 Institution provides opportunities for developing competencies and
skills in different functional areas through specially designed
activities / experiences that include
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7. Community Engagement




DUTY SHEET



MIER COLLEGE OF EDUCATION (Autonomous)
(Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu)
Accredited by the NAAC with grade ‘A+’

Extension Unit

DUTY SHEET
Date: 8"April,2024
Time: 11.00 AM.
Venue: Purkhoo Village
Event: World Health Day
S.No. Arrangements Name Signature
I Venue arrangements | Ms. Shruti (Roll no.18, B.Ed.Sem-1II) S @\WW"‘
,"//’M
Ms. Bhavya (Roll no.2, B.Ed.Sem-III) W
2. Welcome address Ms. Snober (Roll no.12, B.Ed.Sem-I11) %W_xvﬂ
Py usill
i 2 Photography Mr. Sahil T,
4. | Press Coverage Dr. Bharti Tandon 60){, 1A
. 1 Seating Arrangement | Ms. Ranju (Roll no.5, B.Ed.Sem-I) M(/
and Discipline 0 |
p Mr..Avinab Badyal (Roll no.41, B.Ed.Sem-I) éd’\"f_&ﬁ.}té“‘&‘
6. Vote of Thanks Ms. Shalini (Roll no.66, B.Ed.Sem-III) W\W
1. Overall Incharge Mrs. Suman Devi g
sy Q R

Qs Do

In-charge HOD SOE HOD SSSH




MIER COLLEGE OF EDUCATION (Autonomous)
(Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu)
Accredited by the NAAC with grade *A+’

Extension Unit

DUTY SHEET
Date: 21% February,2024
Time: 11.00 AM.
Venue: Purkhoo Village
Event: Importance of Voting
S.No. Arrangements Name Signature

Venue arrangements

Ms

. Alinita Katoch (Roll no.4, B.Ed.Sc:n-I)

R rl«\é:{‘_;l”

Ms. Bhavya (Roll no.2, B.Ed.Sem-III) @J\M

i Welcome address Ms. Ashia Choudhary (Roll no.. ., B.Ed.Sem-17) @ %
3. Seating Arrangement | Ms. Chavi (Roll no.1, B.Ed.Sem-I) Q},&.\H

and Discipline Ms. Archna Dubey (Roll no.3, B.Ed.Spl.Sem-I) 0 sal

—

4. Photography Mr. Sahil g g
£ Press Coverage Dr. Bharti Tandon 5./4,—4 Siaab A
6. Vote of Thanks Ms. Sonia Choudhary (Roll no.1, M.Ed.Sem-11I) /o:;f
e Overall Incharge Mrs. Suman Devi

s

HOD SOE

HOD SSSH




# MIER COLLEGE OF EDUCATION (Autonomous)

(Recognized by the Govt. of J&K & Permanently Affiliated to the University of Jammu)
( Accredited by the NAAC with grade ‘A+)

Extension Unit

DUTY SHEET
Date: 6" December, 2023
Time: 11.00 AM.
Venue: Purkhoo Village
Event: Nukkad Natak on Aids
S.No. Arrangements Name Signature
I | Venue arrangements | Ms. Ridham (Sem-111, B.Ed.) Roll no. 49 D’(@M/
2 Welcome Ms. Snober (Sem-III, B.Ed.) Roll no. 12 W
3. | Photography Mr. Anish g 41\
4. | Narrators Ms. Snober (Sem-III, B.Ed.) SwWobtl
Ms. Bhavya Gupta (Sem-III, B.Ed.) W
5. | Press Coverage Dr. Bharti Tandon (
(= L
6. Seating Arrangement | Samridhi ( B.Ed. Sem-III) Roll no. 63 QJ'M,_’:__‘?.‘L"/
and Discipline Sanjena (B.Ed. Sem-III) Roll no. 31 Qow\m
7. | Vote of Thanks Ms. Bhavya Gupta (Sem-I1I, B.Ed.) w,
8. | Overall Incharge Mrs. Suman Devi Incharge Extension Unit ‘5}“"”\“7 p
Ay

gu-"""-éu‘] 0% !
In-charge

Extension Unit

Ve
HOD
SSSH
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2.4.1 Institution provides opportunities for developing competencies and
skills in different functional areas through specially designed
activities / experiences that include

8. Facilitating Inclusive Education




LETTERS TO
PRINCIPAL FOR
RESOURCE ROOM
AND GROUP
TEACHING
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NO: MCE/SOE/2024/300
DT: 01/03/2024

To,

The Principal,

Model Academy Inclusive School,
Jammu.

Subject: Request for conduct of Practical Component (IEP Resource Room).

Respected Sir,

This is to express our utmost gratitude for the opportunity you had given to our B.Ed.
Special Education students in previous semester for gaining actual field experience in your
esteemed school. For this academic session too, | would like to request you to
accommodate student teachers of Semester-lll session 2022-24 to complete the Practical
Component (Resource Room) of Course Code 307 Practical Disability Specialization and
Semester-| session 2023-2025 Course Code-107 Cross Disability & Inclusion.

In this connection 30 student teachers alongwith group supervisors will be visiting your
school for 25 days (4t March,2024 to 29t March, 2024) at 10.00 a.m. to 11.00 a.m. in
order to complete their above mentioned component. In this regard, Dr. Behzaad
Magbool, Associate Professor & Mr. C.R. Jangra, Assistant Professor MIER College of
Education will be coordinating with you for the smooth conduct of above mentioned
Practical Components.

| hope and believe you will be kind enough to cooperate and accommodate us for the
above said purpose.

Thanks 8$ Regards

Lt

Dr. Nishta Rana

HOD %
School of Education \”l,«\

\
Copy to:
1. Principal MIER College of Education Q_M i
2. Joint Director /
3. Incharge inclusive School %f/fg/
4.  Special Educators of Inclusive School "r

https://mail.google.com/mail/u/0/#inbox?projector=1

17
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N MIER COLLEGE OF EDUCATION  lsoxesemue sscoummer

: . Autonom
College with Potential for Excellence Status by the 8:(5:

To

The Principal,
Model Academy Inclusive School,
B.C. Road, Jammu.

Respected Sir,

Permanently Affiliated to the University of Jammuy
Recognised by the UGC under Section 2(f) & 12(B)
Accredlt_ed by the NAAC with 'A" Grade

NO: MCE/SOE/2024/
DT: 13/02/2024

This is to inform you that the Group Teaching Practice of B.Ed. Special Education (D),

semester-lil, Session 2022-2024 of Main Disability Special School (306) is scheduled to be held

w.e.f. 15t February, 2024 to 29th February, 2024 at 10:10 a.m

.to 11:20 a.m. The same shall be

conducted in the Model Academy Inclusive School for which group A/B/C/D of inclusive cell will be

involved. Your goodself is requested to make the necessary arrangements for the smooth conduct

of the same and also ensure your whole hearted cooperation

previous years.

Thanking you in anticipation.

With Regards,

( _._S-m
{3s ¥
N
prof. Nishta Rana

HOD
school of Education

Copy to:

. principal, MIER College of Education
. Joint Director

https://mail.google.com/mail/u/0/#inbox?projector=1

as you have been showing in the

[
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MIER COLLEGE OF EDUCATION (AUTONOMOUS)

(Accredited by NAAC with ‘A+’ Grade)

SESSION 2022-24 (Semester- I1I)
Resource Room Teaching

o)

NAME

PRATHIRHA A TR

ROLL NO:

J20 300 §

CLASS : B.Ed. Special Education (ID)

SUPERVISOR:

™. RBEHZAD MAQBOOL

(./) ( : W
Wﬁ’ bMﬂ“
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1 (Accredited by NAAC with ‘A+’ Grade)

'[ SESSION 2022-2024

SEMESTER- ¥4 l

GROUP TEACHING .

Lo

NAME ..U jp!fx\(ﬂl ...............................................................................

CLASS : B.Ed. Special Education (ID). Roll No:.. 02&0 A00Y. ...
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1) MIER College of Education (Autonomous)
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CRITERION 11
TEACHING LEARNING AND EVALUATION
2.4 Competency and Skill Development

-

2.4.1 Institution provides opportunities for developing competencies and
skills in different functional areas through specially designed
activities / experiences that include

o

9. Preparing Individualized Educational Olan(IEP)




INDIVIDUALIZED
EDUCATIONAL
PLAN(IEP)
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